
 

 

 
ΤΕΧΝΟΛΟΓΙΚΟ ΕΚΠΑΙΔΕΥΤΙΚΟ ΙΔΡΥΜΑ 

ΠΕΙΡΑΙΑ 

 

ΣΧΟΛΗ ΤΕΧΝΟΛΟΓΙΚΩΝ ΕΦΑΡΜΟΓΩΝ 

 

Τμήμα Ηλεκτρολόγων Μηχανικών  

Τ.Ε. 

 

ΠΤΥΧΙΑΚΗ ΕΡΓΑΣΙΑ 

ΘΕΜΑ: 

Βελτίωση της οργάνωσης του μαθήματος: Ηλεκτρολογικό Σχέδιο, του νέου 
προγράμματος σπουδών του Τμήματος Ηλεκτρολογίας, σε 60 ωριαία 

μαθήματα. 

 

ΙΑΝΟΥΑΡΙΟΣ 2014 

 

Κονταξής Μ. Απόστολος  
Παραδείσης I. Γεώργιος  

Καθηγητής: Βερνάδος Πέτρος 
Επιβλέπων: Ζουντουριδου Εριέττα 



ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  i 
 

ΠΕΡΙΕΧΟΜΕΝΑ 
 ________________________________________________________________         

ΚΕΦΑΛΑΙΟ 1: ΕΙΣΑΓΩΓΗ  
 

1.1  Εισαγωγή…………………………………………………...…..σελ.1  
1.1.1    Δομή του μαθήματος........................……….....................σελ.1 

1.2  Σχεδίαση με τη Βοήθεια Ηλεκτρονικού Υπολογιστή ……..….σελ.2 
1.3   Ιστορική Αναδρομή ……..............................………………......σελ. 2         

               

ΚΕΦΑΛΑΙΟ 2: ΤΟ ΣΧΕΔΙΑΣΤΙΚΟ ΠΡΟΓΡΑΜΜΑ AUTOCAD 
 

2.1  Εισαγωγή …………………………………………….......…….σελ.5 

2.2 Το πρόγραμμα AutoCAD …..………………………....….….....σελ.5 

2.3 Το AutoCAD ως εργαλείο μηχανικού……………………...…..σελ.6 

2.4 Τρόπος εισαγωγής εντολών ..............….…….…………..............σελ.6 

     2.4.1 Το παράθυρο του προγράμματος..………………….....…..σελ.7 

              2.4.1.1 Η Λωρίδα....……………………………….…....….σελ.8  

2.4.1.2 Μενού Εφαρμογής………………...……….…...…σελ.9 

2.4.1.3 Η γραμμή  εργαλειών γρήγορης πρόσβασης…......σελ.10 

2.4.1.4 Η γραμμή  κατάστασης…………………………..σελ.11 

2.4.1.5 Το παράθυρο εντολών……………..……………..σελ.12 

2.4.1.6 Η περιοχή σχεδίασης……………....……………..σελ.13 

2.4.1.7 Το εικονίδιο UCS…………….........…….………..σελ.13 

2.4.1.8 Το σταυρόνημα……………..…...........…………..σελ.13 

2.4.2  Εκκίνηση και απόθηκευση νέου σχεδίου...................…..σελ.15 

2.4.3 Μετακίνηση και εστίαση για ρύθμιση της 
προβολής……….…................................…..................….σελ.16 

2.4.3.1   Η εντολή Zoom…………….................................σελ.16 



ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  ii 
 

2.4.3.2  Η εντολή  Pan…………….........................….…...σελ.18 

2.4.4 Αναίρεση ενέργειας……………....................……...σελ.19 

2.5 Τα εργαλεία απεικόνισης του AutoCAD…………...……...σελ.19 

2.5.1 Το σύστημα συντεταγμένων του AutoCAD……...............σελ.19 

2.5.2 Χρήση του εργαλείου δυναμικής εισόδου………….........σελ.21 

2.5.3 Επιλογή των μονάδων σχεδίασης…………......................σελ.21 

2.5.4 Όρια περιοχής σχεδίασης……………............….......…...σελ.22 

2.5.5 Χρήση ψηφιακού οργάνου Τ και τριγώνου………...…...σελ.22 

2.5.5.1 Η κατάσταση Ortho………….....................….…...σελ.22 

2.5.5.2 Η κατάσταση Polar Tracking..................................σελ.23 

2.5.6 Επιλογή ακριβών θέσεων σε αντικείμενα.........................σελ.23 

 2.5.7 Η κατάσταση πλέγματος....................................................σελ.25 

2.5.7.1 Έλξη στο πλέγμα ή σε άλλα ίσα διαστήματα................σελ.25 

2.6 Σχεδίαση διαστάσεων (2D)  αντικειμένων.................................σελ.26 

2.6.1 Σχεδίαση ευθειών γραμμών................................................σελ.27 

2.6.2 Σχεδίαση ορθογωνίων.........................................................σελ.28 

2.6.3 Σχεδίαση κύκλων................................................................σελ.28 

2.6.4 Σχεδίαση τόξων..................................................................σελ.29 

2.6.5 Εισαγωγή κειμένου.............................................................σελ.30 

2.6.6  Σχεδίαση παράλληλων γραμμών......................................σελ.31 

2.7 Επεξεργασία αντικειμένων στο AutoCAD................................σελ.31 

2.7.1 Επιλογή αντικειμένων με παράθυρα.................................σελ.31 

2.7.2 Διαγραφή αντικειμένου......................................................σελ.32 

2.7.3 Μετακίνηση αντικειμένου..................................................σελ.33 



ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  iii 
 

2.7.4 Αντιγραφή αντικειμένου....................................................σελ.34 

2.7.5 Περιστροφή αντικειμένου..................................................σελ.34 

2.7.6 Κλιμάκωση αντικειμένου...................................................σελ.35 

2.8 Οργάνωση με τα επίπεδα.............................................................σελ.36 

2.8.1 Δημιουργία, ενεργοποίηση/απενεργοποίηση και εναλλαγή 
επιπέδων............................................................................σελ.36 

2.9 Σχεδιάζοντας στο AutoCAD (3D) ..............................................σελ.39 

2.9.1 Συντεταγμένες.....................................................................σελ.39 

2.9.2 Εργαλεία διερεύνησης (inquiry tools) ..............................σελ.41 

2.10 Μοντέλα στερεών (Solid models) ............................................σελ.42 

2.11 Εντολές τροποποίησης διδιάστατων προφίλ............................σελ.43 

2.12 Στερεά μέσω ανύψωσης (extruded solids).................................σελ.44 

2.13 Στερεά μέσω περιστροφής (revolved solids).............................σελ.45 

2.14 Πρωτογενή στερεά (primitive solids)........................................σελ.45 

2.15 Boolean operations....................................................................σελ.47 

2.16 Δημιουργία τομών στερεών με τις εντολές SECTION  

και SLICE..................................................................................σελ.48 

2.17 Τρισδιάστατες όψεις..................................................................σελ.51 

2.17.1 Αλλαγή όψης....................................................................σελ.51 

2.17.2 Αλλαγή αριθμού όψεων...................................................σελ.53 

2.18 Εκτυπώνοντας από το AutoCAD...............................................σελ.54 

 

 

 

 



ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  iv 
 

ΚΕΦΑΛΑΙΟ 3: ΕΝΑΡΞΗ ΜΑΘΗΜΑΤΩΝ ΣΤΟ ΕΡΓΑΣΤΗΡΙΟ 
 

3.1 Εισαγωγή - Πρακτική εφαρμογή στο εργαστήριο.......................σελ.56 

3.2 Εργαστηριακές Ασκήσεις............................................................σελ.56 

3.2.1 Εργαστηριακή Άσκηση 1 – Σχεδίαση διαφόρων τύπων 
ελασμάτων πυρήνων μετασχηματιστών............................σελ.57 

3.2.2 Εργαστηριακή Άσκηση 2 – Σχεδίαση ελασμάτων διαφόρων 
παχών.................................................................................σελ.61 

3.2.3 Εργαστηριακή Άσκηση 3 – Σχεδίαση διαφόρων ελασμάτων με 
διαφορετικά πάχη..............................................................σελ.63 

3.2.4 Εργαστηριακή Άσκηση 4 – Σχεδίαση εξαρτήματος σε πρόσοψη, 
πλάγια όψη και κάτοψη. ...................................................σελ.66 

3.2.5 Εργαστηριακή Άσκηση 5 – Σχεδίαση δύο πυρήνων 
μετασχηματιστή σε πρόοψη, κάτοψη και πλάγια όψη. ....σελ.67 

3.2.6 Εργαστηριακή Άσκηση 6 – Σχεδίαση δύο εξαρτημάτων 
στήριξης...........................................................................σελ.68 

3.2.7  Εργαστηριακή Άσκηση 7 – Σχεδίαση εξαρτήματος 
συμμετρικού ως προς τον άξονα....................................σελ.69 

3.2.8 Εργαστηριακή Άσκηση 8 – Σχεδίαση εξαρτημάτων 
συνδεδεμένων μεταξύ των...............................................σελ.71 

3.2.9 Εργαστηριακή Άσκηση 9 – Σχεδίαση συνδέσεως δύο 
ελασμάτων δια φυτευτών κοχλίων..................................σελ.73 

3.2.10 Εργαστηριακή Άσκηση 10 – Σχεδίαση εξωτερικού κοχλίου 
μετά περικοχλίου...............................................................σελ.73 

3.2.11 Εργαστηριακή Άσκηση 11 – Σχεδίαση εξαρτημάτων, σε 
κάτοψη, πλάγια όψη, πρόοψη..........................................σελ.74 

3.2.12 Εργαστηριακή Άσκηση 12 – Σχεδίαση εξαρτημάτων, σε 
κάτοψη, πλάγια όψη, πρόοψη..........................................σελ.76 

3.2.13 Εργαστηριακή Άσκηση 13 – Σχεδίαση εξαρτημάτων.....σελ.76 



ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  v 
 

3.2.14 Εργαστηριακή Άσκηση 14 – Σχεδίαση εξαρτημάτων.....σελ.80 

3.2.15 Εργαστηριακή Άσκηση 15 – Σχεδίαση εξαρτημάτων.....σελ.81 

 
Συμπεράσματα – Επίλογος........................................................σελ.82 
Βιλιογραφία................................................................................σελ.83 
 

 
 

 



ΚΕΦΑΛΑΙΟ 1: ΕΙΣΑΓΩΓΗ 

 
 

ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  1 
 

ΚΕΦΑΛΑΙΟ 1 
ΕΙΣΑΓΩΓΗ 

 
1.1 Εισαγωγή 

Το μάθημα Ηλεκτρολογικό σχέδιο έχει ως βασικό στόχο να κάνει το σπουδαστή 
ικανό να σχεδιάζει, να ελέγχει και να τροποποιεί σχέδια απλών μηχανολογικών 
εξαρτημάτων, ηλεκτρικών εγκαταστάσεων και κυκλωμάτων. Επίσης να κάνει χρήση 
συμβόλων, προτύπων και κανονισμών. Μετά την παρακολούθηση του μαθήματος ο 
σπουδαστής πρέπει να είναι σε θέση: 

1. Να ορίζει και να σχεδιάζει τις απαραίτητες όψεις των απλών μηχανολογικών 
εξαρτημάτων, να επιλέγει της τομές και να τοποθετεί διαστάσεις, 
χρησιμοποιώντας σύμβολα, πρότυπα και κανονισμούς. 

2. Να αναγνωρίζει τα βασικά ηλεκτρικά κυκλώματα των Ε.Η.Ε. και να 
περιγράφει τον τρόπο λειτουργίας τους. 

3. Να αναλύει και να συνθέτει σχέδια ηλεκτρικών εγκαταστάσεων κατοικιών και 
βιομηχανικών χώρων, κάνοντας χρήση των κανονισμών, των τυποποιημένων 
συμβόλων και προτύπων. 

4. Να εφαρμόζει τα σχέδια μιας μελέτης σύμφωνα με τους ισχύοντες 
κανονισμούς. 

Με την παρούσα εργασία θα γίνει προσπάθεια να βελτιωθεί ο τρόπος παράδοσης του 
μαθήματος και ο σπουδαστής να είναι σε θέση να λάβει όλες τις σύγχρονες γνώσεις 
που απαιτεί ο Τομέας των Μηχανικών. Η εργασία βασίζεται στην παράδοση του 
μαθήματος με τη Βοήθεια Ηλεκτρονικού Υπολογιστή {Computer Aided Design 
(CAD)}, που θα αναλυθεί λεπτομερώς σε απόμενο κεφάλαιο.  

 1.1.1 Δομή του μαθήματος 

Ο σπουδαστής θα λάβει γνώση σε όργανα σχεδίασης και τη χρήση τους, στη 
γραμμογραφία, στα γράμματα, σε κλίμακες, σε υπόμνημα. Επίσης θα ασχοληθεί με 
απλές γεωμετρικές κατασκευές και με Μηχανολογικό σχέδιο. Σε θεωρητικό 
υπόβαθρο θα μελετήσει κανονισμούς και Ηλεκτρολογικά σύμβολα. Σε πρακτικό 
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κομμάτι, η σχεδίαση απλών μηχανολογικών εξαρτημάτων, η επιλογή όψεων και 
τομών, η τοποθέτηση διαστάσεων, τα βασικά ηλεκτρικά κυκλώματα  εσωτερικών 
ηλεκτρικών εγκαταστάσεων (Ε.Η.Ε.), οι πίνακες διανομής, φωτισμού, κίνησης, 
αυτοματισμοί και η σχεδίαση ηλεκτρικών εγκαταστάσεων κατοικιών και 
βιομηχανικών χώρων με τη βοήθεια του με τη βοήθεια Ηλεκτρονικού Υπολογιστή 
αποτελούν τον κύριο κορμό του μαθήματος.  

1.2 Σχεδίαση με τη Βοήθεια Ηλεκτρονικού Υπολογιστή 

Σχεδίαση με τη Βοήθεια Ηλεκτρονικού Υπολογιστή {Computer Aided Design 
(CAD)}, είναι η διεργασία σχεδίασης αντικειμένων και σχεδίων με τη χρήση των 
υπολογιστών. Στις μέρες μας υπάρχουν ειδικευμένα CAD προγράμματα για κάθε 
τύπο σχεδίου όπως: αρχιτεκτονικά, μηχανολογικά, ηλεκτρολογικά, ηλεκτρονικά, κ.α. 
Τα προγράμματα CAD επιτρέπουν τη δισδιάστατη (2D) ή τρισδιάστατη (3D) 
σχεδίαση, γρήγορα και με ακρίβεια Ένα από τα πολλά πλεονεκτήματα της σχεδίασης 
με τη βοήθεια Η/Υ, είναι η δυνατότητα συνεχούς αλλαγής των ήδη 
σχεδιασμένωναντικειμένων σε ελάχιστο χρόνο, η οποία στα παραδοσιακά σχέδια 
ήταν δύσκολη έως αδύνατη. 

Σκοπός της παρούσας εργασίας είναι να αποκτήσει ο αναγνώστης  τις βασικές 
θεωρητικές και πρακτικές γνώσεις σχετικά με τη σχεδίαση με τη βοήθεια υπολογιστή, 
χρησιμοποιώντας το πρόγραμμα AutoCAD της Autodesk, δίνοντας ιδιαίτερη έμφαση 
στο μηχανολογικό και ηλεκτρολογικό σχέδιο. Το πρόγραμμα αυτό αποτελεί σήμερα 
το δημοφιλέστερο πρόγραμμα στον τομέα της σχεδίασης παγκοσμίως με 40 ετή 
τουλάχιστον παρουσία.   

1.3 Ιστορική Αναδρομή 

Οι υπολογιστές έκαναν την πρώτη εμφάνισή τους κατά τη διάρκεια της δεκαετίας 
1940. Οι πρώτες επινοήσεις ήταν ογκώδεις, παρουσίαζαν λειτουργικές δυσκολίες 
κατά τη χρήση τους και εκτελούσαν υπολογισμούς σχετικά αργά, σε σύγκριση με 
τους σύγχρονους ψηφιακούς υπολογιστές. Οι σημερινοί υπολογιστές είναι πιο 
συμπαγείς, πιο γρήγοροι και πιο οικονομικοί από τους προκατόχους τους. 
 
 Οι περιοχές εφαρμογών των υπολογιστών έχουν επίσης αυξηθεί ραγδαία. Οι 
υπολογιστές χρησιμοποιούνται ευρέως στη Μηχανολογία, στις Επιχειρήσεις, στην 
Εκπαίδευση και στην Ιατρική. Εντούτοις, η πιο θεαματική ανάπτυξή τους έχει γίνει 
στον τομέα του CAD – Computer Aided Design. Αυτή η νέα τεχνολογία, που έκανε 
την εμφάνισή της περίπου την τελευταία δεκαετία, έχει συμβάλλει στην τεράστια 
ανάπτυξη της παραγωγικότητας. Η υψηλότερη παραγωγικότητα αποτελεί το 
πρωταρχικό κίνητρο των χρηστών για να αποκτήσουν ένα σύστημα CAD. Το CAD 
παρέχει την ενοποίηση των λειτουργιών σχεδιασμού, ανάλυσης και κατασκευής σε 
ένα σύστημα, το οποία είναι διαθέσιμο στο χρήστη κάθε στιγμή. Επιπλέον, άλλες 
μονότονες (αλλά σημαντικές) και εργασίες ρουτίνας, όπως η προετοιμασία του 
κόστους των υλικών, η κοστολόγηση, ο προγραμματισμός παραγωγής κ.ά. μπορούν 
να γίνουν αυτόματα με χρήση του ίδιου δικτύου υπολογιστών. Ένα άλλο όφελος της 
χρήσης των υπολογιστών είναι η εξοικονόμηση χρόνου από τη σχεδιαστική σκέψη 
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μέχρι την κατασκευή. Το κόστος παραγωγής προϊόντων μπορεί επίσης να μειωθεί 
σημαντικά, καθώς η ανάλυση με τη βοήθεια πεπερασμένων στοιχείων μπορεί να 
συνδεθεί με το σχεδιασμό, με αποτέλεσμα το βέλτιστο σχεδιασμό σε πολύ μικρό 
χρονικό διάστημα. 
 
Κάνοντας μια ιστορική αναδρομή στα συστήματα CAD μπορούμε να πούμε ότι το 
CAD πέρασε από τέσσερις βασικές φάσεις ανάπτυξης στις προηγούμενες 4 δεκαετίες. 
Η πρώτη φάση καταγράφεται στη δεκαετία του 1950 και μπορεί να χαρακτηριστεί 
σαν η αρχή των γραφικών με τη βοήθεια υπολογιστή. Στο ΜΙΤ έγινε δυνατό να 
συνδεθεί οθόνη τηλεόρασης με υπολογιστή για την παραγωγή απλών εικόνων με έναν 
υπολογιστή στα 1950. Στο δεύτερο μισό της δεκαετίας του 1950 ανακαλύφθηκε και 
χρησιμοποιήθηκε η φωτεινή πένα, καθώς επίσης και η ΑΡΤ, η οποία είναι γλώσσα 
αυτόματου προγραμματισμού εργαλείων. Η δεκαετία του 1960 αντιπροσωπεύει την 
πιο κρίσιμη περίοδο ερευνών για τα γραφικά με τη βοήθεια υπολογιστή. Το γεγονός 
ότι οι υπολογιστές βγήκαν έξω από τα ερευνητικά εργαστήρια και χρησιμοποιήθηκαν 
από βιομηχανίες και ερευνητές έδωσε μεγάλη ανάπτυξη στο computer graphics αυτή 
τη δεκαετία. Το 1962 ο Ivan Sutherland παρουσίασε το σύστημα Sketchpad στη 
διδακτορική του διατριβή. Το σύστημα αυτό αποτέλεσε ένα σταθμό στην εξέλιξη του 
CAD, αποδεικνύοντας ότι είναι δυνατόν να δημιουργηθούν σχέδια και διορθώσεις 
αυτών των σχεδίων σε πραγματικό χρόνο μπροστά σε μια οθόνη υπολογιστή. Ο όρος 
Computer Aided Design ή CAD άρχισε να εμφανίζεται την εποχή αυτή. Στα τέλη της 
δεκαετίας του 1960 παρουσιάζονται στην αγορά οθόνες, οι οποίες έχουν τη 
δυνατότητα γραφικών. 
 
Κατά τη διάρκεια της δεκαετίας του 1970 αρχίζουν να αποδίδουν οι ερευνητικές 
προσπάθειες της δεκαετίας του ’60 στη βιομηχανία, τις υπηρεσίες και στην 
ακαδημαϊκό πανεπιστημιακό χώρο. Διοικήσεις σε διάφορες υπηρεσίες και 
βιομηχανίες αρχίζουν να συνειδητοποιούν την επίδραση της νέας CAD τεχνολογίας 
πάνω στη βελτίωση της παραγωγικότητας των υπηρεσιών και των εργασιών 
κατασκευής στα τέλη του ’70. Μέχρι τότε, οι μηχανικοί χρησιμοποιούσαν την 
τεχνολογία αυτή αποκλειστικά για σχεδιαστικού σκοπούς. Αρχίζουν να απαιτούνται 
από τους κατασκευαστές περισσότερες σχεδιαστικές και κατασκευαστικές εφαρμογές 
με τη βοήθεια των υπολογιστών. Επομένως η δεκαετία του 1980 μπορεί να 
χαρακτηριστεί ως δεκαετία της έρευνας των εφαρμογών του CAD. Νέες θεωρίες και 
αλγόριθμοι βρίσκονται. Ο κύριος σκοπός για τη δεκαετία αυτή είναι η ολοκλήρωση 
ή/και η αυτοματοποίηση διαφόρων στοιχείων του σχεδιασμού και της κατασκευής. 
Νέες απαιτήσεις για μηχανολογικές ή γενικά για εφαρμογές μηχανικών 
παρουσιάζονται. Ακριβείς μέθοδοι αναπαραστάσεων επιφανειών αναπτύσσονται, 
βασιζόμενες στους Coons, Bezier και Gordon, καθώς επίσης και B-spline επιφάνειες. 
Οι δυνατότητες υπολογισμού των ιδιοτήτων μάζας, ο αριθμητικός έλεγχος των 
εργαλειομηχανών και οι εφαρμογές πεπερασμένων στοιχείων, οι οποίες υπήρχαν εδώ 
και δεκαετίες, βελτιώνονται. Η ανάπτυξη των CAD συστημάτων έδωσαν ώθηση σε 
άλλες εφαρμογές, όπως μηχανισμοί, ανάλυση και εξομοίωση ρομποτικών 
μηχανισμών, κτλ.  
 
Μια άλλη σημαντική συνεισφορά είναι αρχικά η αποδοχή και η ανάπτυξη της 
θεωρίας της στερεάς αναπαράστασης. Το κύριο πλεονέκτημα της στερεάς 
αναπαράστασης βρίσκεται στο γεγονός ότι δίνει μοναδικές και άνευ σύγχυσης 
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γεωμετρικές αναπαραστάσεις στερεών, που με τη σειρά τους υποστηρίζουν το 
σχεδιασμό και τις κατασκευαστικές εφαρμογές.  
 
Μιλώντας για τη δεκαετία του 1990, θα μπορούσε να πει κανείς ότι η δεκαετία αυτή 
ήταν η δεκαετία της ολοκληρωμένης παραγωγής και του αυτοματοποιημένου 
σχεδιασμού. 
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ΚΕΦΑΛΑΙΟ 2 
ΤΟ ΣΧΕΔΙΑΣΤΙΚΟ 
ΠΡΟΓΡΑΜΜΑ 
AUTOCAD 
2.1  Εισαγωγή 

Στον πρόλογο και την εισαγωγή της εργασίας μας αναφέραμε ότι με την εξέλιξη της 
τεχνολογίας και των λογισμικών προγραμμάτων διευκολύνθηκε πάρα πολύ κάθε 
λογής εργασία που πιο παλιά γινόταν στο χέρι ή σε πιο παλιά προγράμματα που και 
πάλιν ήταν δύσκολα. Σήμερα η ραγδαία εξέλιξη των υπολογιστικών συστημάτων 
αναπτύχθηκε σε όλους τους τομείς και ιδιαίτερα στον σχεδιαστικό τομέα δίνοντας μια 
πλήρη σειρά σχεδιαστικών προγραμμάτων, διευκολύνοντας έτσι όσους ασχολούνται 
με εκπόνηση σχεδίων είτε αρχιτεκτονικών είτε τοπογραφικών είτε μηχανολογικών 
είτε και ηλεκτρολογικών. Τέτοια προγράμματα διατίθενται στην αγορά και μπορεί ο 
κάθε επαγγελματίας ή μη να τα αποκτήσει και να τα λειτουργήσει στο χώρο εργασίας 
του. Ένα από αυτά τα πακέτα είναι και το AutoCAD με το οποίο θα ασχοληθούμε σε 
αυτή την εργασία. Στο μάθημα του Ηλεκτρολογικού σχεδίου θα πραγματοποιηθούν 
συνολικά 60 ώρες μαθημάτων που αοτελούνται από 15 2ωρα θεωρητικής 
εκπαίδευσης και 15 2ωρα στο εργαστήριο, με μορφή εργαστηριακών ασκήσεων, 
όπως θα αναλυθεί σε επόμενο κεφάλαιο. Η θεωρητική εκπαίδευση περιλαμβάνει τη 
γνωριμία των φοιτητών με το περιβάλλον του προγράμματος AutoCAD. 
 
2.2  Το πρόγραμμα AutoCAD 

Tο AutoCAD (εικόνα 2.1) την εμφάνιση του ως σχεδιαστικό πακέτο τον Δεκέμβριο 
του 1982 

 

Εικόνα 2.1 Λογότυπο του προγράμματος 
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Είναι ενταγμένο στην ομάδα προγραμμάτων CAD (Computer Aided Design) αφού 
βασίζεται στη σειρά προγραμμάτων σχεδίασης με βάση τον ηλεκτρονικό υπολογιστή. 
Χρησιμοποιείται για την δημιουργία, διαχείριση και εκτύπωση πολύπλοκων σχεδίων. 
Διαθέτει δυναμικό περιβάλλον, βάση δεδομένων και ομάδα από εργαλεία για 
μοντελοποίηση, ανάλυση και αναπαράσταση συστημάτων 2 και 3 διαστάσεων. 
Υπάρχει δηλαδή η δυνατότητα της ανάκλησης οποιοδήποτε σχεδίου, της διόρθωσης 
του, της πρόσθεσης κάτι σε αυτό ή της αφαίρεσής του. Επίσης με νέα εργαλεία και 
δυνατότητες διευκολύνει αφάνταστα τον κάθε χρήστη αφού είναι συμβατό και με 
παλαιότερες εκδόσεις. Με το AutoCAD η αξία των παραγόμενων σχεδίων 
μεγιστοποιείται. Η επεξεργασία, η διαμόρφωση, η κοινοποίηση των σχεδίων γίνεται 
πλέον σε πραγματικό χρόνο εύκολα, γρήγορα και πάντα με τη γνωστή ακρίβεια του 
AutoCAD. Μέσα από το Internet ή κάποιο τοπικό δίκτυο ολόκληρη η ομάδα μελέτης 
μοιράζεται τις εργασίες, επιταχύνοντας έτσι την ολοκλήρωση του έργου. 
 
2.3  Το AutoCAD ως εργαλείο μηχανικού 

 
Το AutoCAD, όπως έχει αναφερθεί πρωτύτερα, είναι παγκοσμίως το πιο διαδεδομένο 
σχεδιαστικό πρόγραμμα. Σχεδόν όλοι οι σχεδιαστές και οι μηχανικοί έχουν δουλέψει 
με το AutoCAD είτε ως φοιτητές είτε στην επαγγελματική τους πορεία, αξιοποιώντας 
ο καθένας τις αναρίθμητες λειτουργίες του και προσαρμόζοντάς το στις ανάγκες του, 
προκειμένου να φέρει εις πέρας κάποιο σχέδιο. 
 
Οι μηχανολόγοι χρησιμοποιούν το AutoCAD Mechanical και το Autodesk Inventor. 
Οι αρχιτέκτονες το AutoCAD Architecture και το Autodesk Revit. Οι τοπογράφοι το 
AutoCAD Map 3D και το AutoCAD Civil 3D. Αξίζει να σημειωθεί ότι υπάρχει και 
AutoCAD Electrical το οποίο χρησιμοποιούν όσοι ασχολούνται με ηλεκτρολογικά, 
μέσω του οποίου μπορούν να σχεδιάσουν και να δουν τη λειτουργία εξειδικευμένων 
σχεδίων τα οποία είναι ανθρωπίνως σχεδόν αδύνατον να τα αντιληφθεί το ανθρώπινο 
μυαλό. 
 
2.4 Τρόπος εισαγωγής εντολών 
 
Το AutoCad έχει, εν γένει, τρεις τρόπους για την εισαγωγή εντολών, με χρήση 
πληκτρολογίου, με χρήση μενού και χρήση εικονιδίων. Η χρήση πληκτρολογίου είναι 
η πιο γρήγορη, ιδίως αν χρησιμοποιηθούν συντομεύσεις (abbreviations), με 
μειονέκτημα ότι πρέπει ο χρήστης να θυμάται τις εντολές. 
 
Επίσης δίνει τη δυνατότητα για πολλές παραλλαγές μίας εντολής, όπως η δημιουργία 
κύκλου από κέντρο και ακτίνα, ή από κέντρο και διάμετρο, ή από τρία σημεία. Η 
χρήση μενού είναι η πιο εύκολη, αφού οι εντολές εμφανίζονται στην οθόνη, αλλά 
είναι η πιο χρονοβόρα. Τέλος η χρήση εικονιδίων είναι ενδιάμεση, διότι απαιτεί 
εξοικείωση με το τι σημαίνει το κάθε εικονίδιο. 
 
Το AutoCad έχει τη δυνατότητα να αναιρεί την προηγούμενη εντολή που έδωσε ο 
χρήστης με κάποιον από τους τρόπους εισαγωγής. Η αναίρεση γίνεται με την εντολή 
UNDO. Επίσης έχει τη δυνατότητα να εκτελέσει πάλι την εντολή που αναιρέθηκε, 
εκτελώντας την εντολή REDO, αμέσως μετά από την εντολή UNDO. 
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Μπορεί να γίνει αναίρεση πολλών προηγούμενων εντολών χρησιμοποιώντας UNDO 
πολλές φορές. Η εντολή REDO όμως μπορεί να γίνει μόνο μία φορά. 
 

2.4.1 Το παράθυρο του προγράμματος 

Το AutoCad λειτουργεί όπως τα περισσότερα άλλα προγράμματα γραφικών 
παραθυρικού περιβάλλοντος. Το πρόγραμμα έχει περιβάλλον σχεδίασης και σε τρεις 
διαστάσεις (3D).  

Το πρόγραμμα ξεκινά σε περιβάλλον Microsoft Windows (7) πατώντας Start → All 
Programs → Autodesk → AutoCad 2012. Επίσης μπορεί να γίνει με διπλό κλικ στο 
εικονίδιο Autocad 2012 στην επιφάνεια εργασίας των Windows. Αυτό που 
εμφανίζεται όταν ξεκινά το πρόγραμμα (εικόνα 2.2), φαίνεται να είναι ένας κενός 
χώρος δύο διαστάσεων περικλειόμενος από διάφορα μενού και λωρίδες εργαλειών τα 
οποία εξηγούνται αργότερα.  

 

 
Εικόνα 2.2 Το παράθυρο εκκίνησης του Autocad 
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2.4.1.1 Η Λωρίδα  

Η Λωρίδα (Ribbon) (εικόνα 2.3) περιέχει τις πιο κοινές λειτουργίες που θα 
χρειαστούν. Μοιάζει με μία μεγάλη γραμμή εργαλειών, η οποία προσφέρει πολλές 
χρήσιμες πληροφορίες και γρήγορη πρόσβαση στα εργαλεία που χρησιμοποιούνται 
πιο συχνά. 

 

 

Εικόνα 2.3 Η Λωρίδα (Ribbon) 

 

Η γραμμή εργαλειών περιέχει αρκετούς πίνακες (panels) (εικόνα 2.4), κάθε ένας από 
τους οποίους περιέχει ένα σύνολο από εικονίδια που αναπαριστούν εργαλεία για 
σχεδίαση και επεξεργασία. Το σύνολο των πινάκων αλλάζει ανάλογα με την καρτέλα 
της λωρίδας που επιλέγεται. Πέρα από τα ορατά εργαλεία, υπάρχουν μερικά εργαλεία 
που δεν εμφανίζονται. Κάνοντας κλικ στη γραμμή τίτλου του πίνακα, αμέσως ο 
πίνακας επεκτείνεται και εμφανίζονται και τα νέα εργαλεία. 
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Εικόνα 2.4 Οι πίνακες της λωρίδας Home 

Μερικά παό τα εργαλεία έχουν ένα τριγωνικό βέλος δίπλα τους, το οποίο κάνοντας 
κλικ πάνω του ανοίγουν αιωρούμενα (flyout) μενού που περιέχουν επιλογές που 
σχετίζονται με το εργαλείο που θα χρησιμοποιηθεί. 

Τα εργαλεία των πινάκων προσφέρουν επίσης κάποιες συμβουλές εργαλείων, από τις 
οποίες μπορούν να παρθούν πολλές πληροφορίες, όπως μια περιγραφή που βοηθά να 
κατανοηθεί τα αναπαριστούν. Αυτό γίνεται μετακινώντας το δρομέα σε ένα από τα 
εργαλεία του πίνακα λωρίδας και αφήνοντας το εκεί για λίγο. Στην αρχή εμφανίζεται 
η συμβουλή η οποία περιγράφει σύντομα το εργαλείο, αλλά αφήνοντας το δρομέα 
εκεί λίγο ακόμα, η συμβουλή επεκτείνεται, ώστε να παρουσιάσει περισσότερες 
πληροφορίες για τη χρήση του εργαλείου. 

2.4.1.2 Μενού Εφαρμογής 

Κάνοντας κλικ στο λογότυπο του AutoCAD 2012 στην πάνω αριστερή γωνία του 
παραθύρου, ανοίγει το μενού εφαρμογής (Application Menu), το οποίο προσφέρει 
γενικά εργαλεία που σχετίζονται με τα αρχεία. 

Στην αρχή του μενού εφαρμογής φαίνεται το εργαλείο Search (αναζήτηση) (εικόνα 
2.5). Αυτό το εργαλείο δίνει τη δυνατότητα της εύρεσης ενός συγκεκριμένου 
εργαλείου με το όνομα του, πληκτρολογώντας το όνομα μέσα στο πλαίσιο εισαγωγής. 
Ακριβώς από κάτω αριστερά, υπάρχουν δύο εικονίδια με τα οποία κάνοντας κλικ  στο 
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ένα, γίνεται προσπέλαση των πιο πρόσφατων εγγράφων (Recent Documents) και στο 
άλλο των ανοιχτών εγγράφων (Open Documents). 

Σε μία λίστα σχεδίων, αφήνονταςτο δρομέα πάνω στο όνομα του σχεδίου φαίνεται 
μία μικρογραφία του. Ακόμα κάνοντας κλικ στο εργαλείο File View στο πάνω μέρος 
της λίστας, αλλάζει ο τρόπος εμφάνισης των στοιχείων της λίστας σχεδίων. 

Επίσης υπάρχουν πολλές από τις βασικές επιλγές μενού των Windows, όπως οι 
εντολές File (αρχείο), Edit (επεξεργασία) και Help (βοήθεια), όπως και μερικές που 
αφορούν μόνο το AutoCAD. Πολλές από τις επιλογές εμφανίζονται με κεφαλές 
βελών που υποδηλώνουν ότι υπάρχει ένα διαδοχικό μενού. 

 

Εικόνα 2.5 Το μενού εφαρμογής 

 

2.4.1.3 Η γραμμή  εργαλειών γρήγορης πρόσβασης 

Η γραμή εργαλειών γρήγορης πρόσβασης (Quick Access toolbar) (εικόνα 2.6) 
προσφέρει τις πιο κοινές λειτουργίες των Windows για αποθήκευση (Save), αναίρεση 
(Undo), επανάληψη (Redo) και εκτύπωση (Print). 
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Εικόνα 2.6 Γραμή εργαλειών γρήγορης πρόσβασης 

 

Η γραμμή εργαλειών μπορεί να διαμορφωθεί, προσθέτοντας και αφαιρώντας σε αυτή 
οποιοδήποτε εργαλείο για γρηγορότερη προσπέλαση. Αυτό γίνεται κάνοντας κλικ στο 
τριγωνικό βέλος δίπλα στο τελευταίο εργαλείο της γραμμής και στην επιλογή More 
Commands. Έτσι εμφανίζεται το παράθυρο διαλόγου Customize User Interface στο 
οποίο διαλέγεται όποιο εργαλείο χρειάζεται και γίνεται κλικ στο ΟΚ. 

2.4.1.4 Η γραμμή  κατάστασης 

Στο κάτω μέρος της οθόνης βρίσκεται η γραμμή κατάστασης (status bar) (εικόνα 2.7), 
η οποία παρέχει πληροφορίες σχετικά με πολλές από τις ρυθμίσεις που 
χρησιμοποιούνται κοινώς στο AutoCAD. 

Στην αρχή της γραμμής κατάστασης βρίσκονται οι καρτεσιανές συντεταγμένες οι 
οποίες δείχνουν σε πραγματικό χρόνο την ακριβή θέση του σταυρονήματος. 

Η γραμμή κατάστασης προσφέρει στοιχεία ελέγχου για πολλές από τις διαφορετικές 
καταστάσεις του AutoCAD, όπως η Snap Mode, Grid Display, Ortho Mode, Polar 
Tracking, Object Snaps, Object Snap Tracking και Dynamic Input για τις οποίες θα 
υπάρξει αναφορά στη συνέχεια. 
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 Μπάρες εργαλείων 

 

Εικόνα 2.7 Η γραμμή  κατάστασης 

2.4.1.5 Το παράθυρο εντολών 

Αμέσως πάνω από τη γραμμή κατάστασης βρίσκεται το παράθυρο ή γραμμή εντολών 
(command window) (Εικόνα 2.8), ένα στοιχείο μοναδικό στο AutoCAD. Η γραμμή 
εντολών είναι ένα παράθυρο κειμένου όπου εμφανίζονται οι εντολές ενώ 
χρησιμοποιούνται. 

 

 

 

 

Εικόνα 2.8 Το παράθυρο εντολών 

Το κλειδί επιτυχίας στο AutoCAD είναι να καταλάβει κανείς τον τρόπο με τον οποίο 
αλληλεπιδρά μαζί του. Μέσω της γραμμής εντολών μπορεί να γίνει είσοδος εντολών 
ή τιμών από το πληκτρολόγιο και εμφάνιη μηνυμάτων που ζητούν να εκτελεστεί ένα 
βήμα σε κάποια εντολή. 

Όλες σχεδόν οι εντολές στο AutoCAD προσφέρουν ένα σύνολο επιλογών που 
εμφανίζονται και αυτές στη γραμμή του παραθύρου εντολών (Εικόνα 2.9). Όταν 
ενεργοποιηθεί μία εντολή και δοθούν εντός παρενθέσεων ([.../.../...]) κάποιες 
επιλογές, για να ενεργοποιηθούν, αναγράφονται μόνο τα κεφαλαία γράμματα όπως 
παρουσιάζονται εντός των παρενθέσεων και πατιέται το πλήκτρο Enter. Στην 
συνέχεια όποτε πρέπει να πατιέται το πλήκτρο Enter, θα αναφέρεται απλά η φράση 
«και Enter». 

Αυτές οι επιλογές επιτρέπουν την αλλαγή της συμπεριφοράς μιας εντολής, έτσι ώστε 
να ταιριάζει με το τρέχον σχέδιο. Δηλαδή δίνεται πρώτα μια εντολή, η οποία με τη 
σειρά της παρουσιάζει επιλογές με τη μορφή ερωτήσεων. 
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Εικόνα 2.9 Οι επιλογές που προσφέρει η εντολή Zoom 

Ανάλογα με την επιλγή του χρήστη, εφανίζεται ακόμα ένα πακέτο επιλογών ή το 
πρόγραμμα ζητά να εκτελεστεί κάποια ενέργεια όπως η επιλογή ενός σημείου, η 
επιλογή αντικειμένων ή η εισαγωγή μιας τιμής. 

Γενικά το παράθυρο εντολών ενημερώνει το χρήστη για όλα όσα το πρόγραμμα 
περιμένει από αυτόν και επίσης παρουσιάζει τις πληροφορίες που δίνει το AutoCAD 
όταν του ζητηθεί κάτι. Μοιάζει με τα παράθυρα συζήτησης (chat room) που συναντά 
κανείς στο διαδίκτυο (Internet). 

2.4.1.6 Η περιοχή σχεδίασης 

Στο κέντρο του παραθύρου του AutoCAD βρίσκεται η περιοχή σχεδίασης (drawing 
area), όπου θα δημιουργηθούν τα σχέδια (Εικόνα 2.10). 

2.4.1.7 Το εικονίδιο UCS 

Το εικονίδιο UCS είναι το εικονίδιο σε σχήμα L φαίνεται στην λάρω αριστερή γωνία 
της περιοχής σχεδίασης (Εικόνα 2.10). Τα UCS είναι τα αρχικά των λέξεων User 
Coordinate System (σύστημα συντεταγμένων χρήστη). Αυτό βοηθά στην εύρεση του 
προσανατολισμού με μια ματιά, καθώς δείχνει τις διευθύνσεις Χ και Υ. Το AutoCAD 
δίνει τη συνατότητα της αλλαγής του προσανατολισμού της προβολής, όπως και η 
χρήση επιπλέον συστήματος συντεταγμένων. 

 2.4.1.8 Το σταυρόνημα 

Το σταυρόνημα επιτρέπει στο χρήστη να καταδεικνύει συγκεκριμένα κομμάτια της 
περιοχής σχεδίασης, για την επιλογή κάποιου αντικειμένου ή ομάδα αντικειμένων. 

Η εμφάνιση των αριθμών, η οποία είναι γνωστή ως εμφάνιση δυναμικής εισόδου, 
δίνει τις συντεταγμένες  Χ και Υ μέσα στην περιοχή σχεδίασης. Οι συντεταγμένες 
ΧΥ φαίνονται επίσης στην αριστερή άκρη της γραμμής κατάστασης, στην κάτω 
αριστερή γωνία του παραθύρου του AutoCAD (Εικόνα 2.11). 

Η περιοχή σχεδίασης και το σταυρόνημα, η γραμμή κατάστασης και το παράθυρο 
εντολών συνεργάζονατι, ώστε να προσφέρουν ανάδραση ενώ σχεδιάζεται και 
επεξεργάζεατι ένα σχέδιο. 
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Εικόνα 2.10 Η περιοχή σχεδίασης και το εικονίδιο UCS 

 

 

 

Εικόνα 2.11 Το σταυρόνημα και οι συντεταγμένες ΧΥ 
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2.4.2  Εκκίνηση και απόθηκευση νέου σχεδίου 

Η δημιουργία ενός σχεδίου AutoCAD είναι λίγο διαφορετική από τα άλλα 
προγράμματα αλλά παραμένει αρκετά απλή. Από το μενού εφαρμογής επιλέγεται το 
εργαλείο New, ώστε να εμφανιστεί το παράθυρο διαλόγου Select Template (Εικόνα 
2.12). Tο εργαλείο New υπάρχει επίσης στη γραμμή εργαλειών γρήγορης πρόσβασης. 
Επιλέγεται το αρχείο πρότυπου acad.dwt και μετά γίνεται κλικ στο Open για να 
ανοίξει ένα κενό παράθυρο σχεδίου. 

Στη συνέχεια για να δοθεί στο αρχείο ένα μοναδικό όνομα, επιλέγεται File → Save 
As για να εμφανιστεί το παράθυρο διαλόγου Save Drawing As. Εισάγεται το όνομα 
επιλογής στο πλαίσιο κειμένου File Name. Αφού προσδιοριστεί σε ποιο χώρο θα γίνει 
αποθήκευση του αρχείου, γίνεται κλικ στο Save. Έτσι έχει δημιουργηθεί ένα κενό 
αρχείο.  

Το πρότυπο αρχείο acad.dwt που επιλέχθηκε είναι ένα αρχείιο AutoCAD που έχει 
συγκεκριμένες ρυθμίσεις. Το AutoCAD χρησιμοποιεί αυτές τις ρυθμίσεις για να 
δημιουργεί νέα αρχεία. Όπως φάνηκε, στο παράθυρο διαλόγου Select Template, 
γίνεται επιλογή μεταξύ πολλών τέτοιων προτύπων. Η περιοχή σχεδίασης που 
φαίνεται αρχικά είναι ο χώρος εργασίας, ο οποίος είναι απεριόριστός. Δεν υπάρχουν 
οπτικές ενδείξεις για το μέγεθος αυτής της περιοχής. Πολύ βασικό γνώρισμα της 
περιοχής σχεδίασης είναι ότι δεν υπάρχουν μονάδες μέτρησης αλλά μονάδες μήκους 
οι οποίες αποκτούν νόημα σε φυσικό επίπεδο ανάλογα με την κλίμακα εκτύπωσης 
που χρησιμοποιείται μετά την ολοκλήρωση της σχεδίασης. Μπορεί να ξεκινήσει η 
σχεδίαση αμέσως, χωρίς να προσδιοριστούν οι μονάδες που θα χρησιμοποιηθούν, 
αφού αυτό μπορεί να γίνει και αργότερα. Όταν τελειώσουν οι εργασίες στο σχέδιο 
τότε πρέπει να αποθηκευτεί. Από το μενού εφαρμογής ή από τη γραμμή εργαλείων 
γρήγορης πρόσβασης γίνεται κλικ στο εργαλείο Save. 

 

 

 



ΚΕΦΑΛΑΙΟ 2: ΤΟ ΣΧΕΔΙΑΣΤΙΚΟ ΠΡΟΓΡΑΜΜΑ AUTOCAD 

 
 

ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  16 
 

 

Εικόνα 2.12 - Το παράθυρο διαλόγου Select template 

2.4.3  Μετακίνηση και εστίαση για ρύθμιση της προβολής 

Ένα από τα πιο σημαντικά στοιχεία του AutoCAD είναι η ικανότητα του να σχεδιάζει 
με ακρίβεια σε ένα μεγάλο εύρος κλιμάκων. Για να το πετύχει αυτό ο χρήστης, πρέπει 
να γνωρίζει καλά τα εργαλεία προβολής του AutoCAD. Οι εντολές Zoom και Pan 
είναι αυτές που χρησιμοποιούνται πιο συχνά από τις λειτουργίες προβολής. 

2.4.3.1  Η εντολή Zoom 

Κάνοντας κλικ στο τριγωνικό βέλος δίπλα από το εικονίδιο με το μεγεθυντικό φακό , 
το οποίο φαίνεται στον πίνακα Navigate της καρτέλας  View, εμφανίζεται ένα μενού 
με αρκετές επιλογές  (εικόνα 2.13) με τις πιο χρήσιμες στον πίνακα 2.1. 
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Εικόνα 2.13 - Οι επιλογές του εργαλείου Zoom 

Όλες οι επιλογές μπορούν να εμφανιστούν στο παράθυρο εντολών πληκτρολογώντας 
την εντολή  Zoom. Για να γίνει κάποια επιλογή πρέπει ο χρήστης να πληκτρολογήσει 
το πρώτο γράμμα της επιλογής  που επιθυμεί. 

Ένας άλλος τρόπος είναι , αν ο χρήστης διαθέτει ένα τυπικό ποντίκι με ροδέλα, 
μπορεί να το χρησιμοποιήσει ώστε να μειώσει ή να αυξήσει το επίπεδο εστίασης στο 
σχέδιο του. Κυλώντας την ροδέλα μπορεί να εστιάσει, ενώ κάνοντας διπλό κλικ με τη 
ροδέλα θέτει σε εφαρμογή την επιλογή  Extents. 
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2.4.3.2  Η εντολή  Pan  

 

Εικόνα 2.14 - Οι επιλογή του εργαλείου Pan 

Για την μετακίνηση του σχεδίου χρησιμοποιείται η εντολή Pan. Για την επιλογή της 
εντολής Pan, γίνεται κλικ στο εργαλείο Pan το οποίο φαίνεται στον πίνακα Navigate 
της καρτέλας View (εικόνα 2.16), και αμέσως το σταυρόνημα παίρνει το σχήμα 
χεριού. Μπορεί επίσης να τεθεί σε εφαρμογή πληκτρολογώντας pan στη γραμμή 
εντολών και Enter. 

 
Extents εμφανίζει μια προβολή που περικλείει όλα τα αντικείμενα του 

σχεδίου, αγνοώντας τα όρια του 
 

Window 
μεγεθύνει μια περιοχή του σχεδίου η οποία περιέχεται σε ένα  
οητό παραλληλόγραμμο το οποίο επιλέγεται σύροντας το 
ποντίκι διαγώνια 

 Previous 
 

εμφανίζει την προηγούμενη προβολή σαν μια εντολή Undo 
για την εντολή Zoom 

 Realtime 
 

κάνοντας κλικ και να σύροντας το ποντίκι πάνω ή κάτω, 
αλλάζει το επίπεδο εστίασης σε πραγματικό χρόνο 

 
All εμφανίζει την περιοχή του σχεδίου 

 Scale 
 

επιτρέπει τη σμίκρυνση ή τη μεγέθυνση του επιπέδου 
μεγέθυνσης σύμφωνα με μια τιμή συγκεκριμένη τιμή 

 Center 
 επιτρέπει την εστίαση σε ένα σημείο στο κέντρο της οθόνης 

 Object 
 

επιτρέπει την επιλογή μιας περιοχή προβολής στην περιοχή 
που καταλαμβάνεται από ένα αντικείμενο 

 In 
 

είναι το ίδιο με τη χρήση της επιλογής Scale και της 
πληκτρολόγησης 2x προκειμένου να αυξηθεί η μεγέθυνση 
κατά δύο φορές 

 Out 
 

είναι το ίδιο με τη χρήση της επιλογής Scale και της 
πληκτρολόγησης 0.5x προκειμένου σμικρύνει το σχέδιο κατά 
δύο φορές 

 

Πίνακας 2.1 - Οι επιλογές της εντολής Zoom 
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Στη συνέχεια κάνοντας κλικ σε ένα σημείο στο σχέδιο γίνεται  η μετακίνηση σε όποια 
κατεύθυνση επιθυμεί ο χρήστης. Ένας ακόμα πιο εύκολος τρόπος είναι αν διαθέτει ο 
χρήστης το τυπικό ποντίκι με ροδέλα, απλά πατώντας την και σύροντας το ποντίκι. 

 

2.4.4 Αναίρεση ενέργειας 

Όλοι  κάνουν  λάθη και θα ήταν αδύνατον να ολοκληρωθεί κάποια εργασία αν δεν 
υπήρχαν κάποιες βοηθητικές λειτουργίες ή πλήκτρα ώστε να διορθωθεί το πρόβλημα 
και να μην χρειαστεί η εκκίνηση της εργασίας από την αρχή. 

Σε  περίπτωση που γίνει κάποιο ορθογραφικό λάθος, ο χρήστης μπορεί να πατήσει το 
πλήκτρο   Backspace  για να το διορθώσει και να πληκτρολογήσει ξανά την εντολή. 
Επίσης όταν πρέπει να βγει γρήγορα από μια εντολή  ή ένα παράθυρο διαλόγου χωρίς 
να εφαρμόσει αλλαγές, πατά απλώς το πλήκτρο  Esc. 

Εάν αλλάξει κατά λάθος κάτι στο σχέδιο και θέλει να αναιρέσει αυτή την αλλαγή, 
μπορεί να κάνει κλικ στο εργαλείο  Undo  στη γραμμή εργαλείων γρήγορης  
πρόσβασης.  Κάθε φορά που το κάνει το  AutoCAD αναιρεί την τελευταία ενέργεια 
μέχρι να φθάσει εντελώς στην αρχή. 

Εάν ο χρήστης αναιρέσει κατά λάθος περισσότερες εντολές από αυτές που θέλει, 
μπορεί να αναιρέσει την τελευταία αναίρεση και να εκτελέσει και πάλι την εντολή με 
ένα κλικ στο εργαλείο Redo  στη γραμμή εργαλείων γρήγορης πρόσβασης. 

2.5 Τα εργαλεία απεικόνισης του AutoCAD 

Πολλά προγράμματα επιτρέπουν τον σχεδιασμό γραμμών, κύκλων, τόξων, αλλά το 
AutoCAD επιτρέπει τον σχεδιασμό με ένα επίπεδο ακριβείας που αφήνει πίσω τα 
περισσότερα σχεδιαστικά προγράμματα. Για να εκμεταλλευτεί κανείς αυτό το 
πλεονέκτημα πρέπει να γνωρίζει καλά πώς να χρησιμοποιεί τα εργαλεία απεικόνισης   
(drafting tools) τα οποία του επιτρέπουν να τοποθετεί αντικείμενα ακριβώς εκεί που 
τα θέλει. 

2.5.1 Το σύστημα συντεταγμένων του AutoCAD 

Οι συντεταγμένες είναι πολύ σημαντικό στοιχείο επειδή επιτρέπουν στο χρήστη να 
ορίσει συγκεκριμένες θέσεις στο σχέδιο του. Οι συντεταγμένες χρησιμοποιούνται 
αρκετά συχνά για τον ορισμό του μεγέθους και τη θέση αντικειμένων, στη 
μετακίνηση και στην αντιγραφή αντικειμένων σε σχέση με άλλα. 

Το   AutoCAD  χρησιμοποιεί καρτεσιανές συντεταγμένες με ένα οριζόντιο άξονα Χ 
και ένα κατακόρυφο άξονα Υ. Σε ένα νέο σχέδιο, το  AutoCAD δείχνει το θετικό 
διάστημα των Χ και Υ συντεταγμένων με τη θέση 0,0 (αρχή των αξόνων) να 
βρίσκεται στη κάτω αριστερή γωνία της περιοχής σχεδίασης. Η αρχή είναι  μια 
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σημαντική θέση των συντεταγμένων επειδή μπορεί να χρησιμοποιηθεί ως αναφορά 
για πολλά σχέδια. 

Πολλές εντολές του  AutoCAD ζητούν την επιλογή μιας θέσης εισάγοντας ένα 
σημείο. Μπορεί να προσδιοριστούν ακριβείς συντεταγμένες κάνοντας εισαγωγή τις 
συντεταγμένες Χ και Υ, οι οποίες διαχωρίζονται με κόμμα. Η συντεταγμένη Χ 
δίνεται πρώτη και μετά δίνεται η Υ. Για παράδειγμα  (εικόνα 2.17 αριστερά ) μια 
θέση που είναι 3 μονάδες στον άξονα Χ και 4 στον άξονα Υ, εισάγεται ως 3,4. Η 
εισαγωγή συντεταγμένων με αυτόν τον τρόπο είναι η χρήση απόλυτων 
συντεταγμένων, και αυτές είναι ακριβείς θέσεις στο συνολικό σύστημα 
συντεταγμένων.  

Τις περισσότερες φορές όμως δεν εισάγονται απόλυτες συντεταγμένες για να 
προσδιοριστούν θέσεις σε ένα σχέδιο,  αλλά καθορίζονται θέσεις που να είναι 
σχετικές ως προς ένα σημείο που επιλέγεται στην περιοχή σχεδίασης. Μπορεί να 
προσδιοριστεί μια απόσταση και μια κατεύθυνση από ένα επιλεγμένο σημείο 
χρησιμοποιώντας σχετικές συντεταγμένες. Ο προσδιορισμός των σχετικών 
συντεταγμένων είναι ο ίδιος με τον απολύτων συντεταγμένων, με την διαφορά ότι 
πρέπει πριν τη συντεταγμένη να γίνεται εισαγωγή του συμβόλου @. 

Ένας άλλος τρόπος να προσδιοριστούν οι αποστάσεις και οι κατευθύνσεις είναι η 
χρήση των πολικών συντεταγμένων. Με τις πολικές συντεταγμένες προσδιορίζεται 
μια απόσταση και μια γωνία. Αν για παράδειγμα πρέπει να γίνει ο προσδιορισμός 
ενός σημείου που απέχει 5 μονάδες από ένα άλλο, σε γωνία 45 ( εικόνας 2.17 δεξιά ), 
εισάγεται @5<45. 

Όπως θα φανεί πιο μετά , μπορεί να μην χρειάζεται να χρησιμοποιούνται 
συντεταγμένες για ότι σχεδιάζεται, αφού μπορεί να μην χρειάζεται   να γίνει επιλογή 
με ακρίβεια θέσεων πάνω σε αντικείμενα, χρησιμοποιώντας objects snaps (σημεία 
έλξης σε αντικείμενα), ή osnaps για συντομία. 

 

Εικόνα 2.15 - Οι καρτεσιανές (αριστερά) και οι πολικές (δεξιά) συντεταγμένες 
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2.5.2 Χρήση του εργαλείου δυναμικής εισόδου 

Το  AutoCAD  περιέχει το εργαλείο δυναμικής εισόδου  Dynamic Input, το οποίο 
αποτελεί ένα είδος διαρκούς προβολής του παράθυρου εντολών. Η δυναμική είσοδος 
προβάλει τις φράσεις του παράθυρου εντολών δίπλα στον δρομέα, ώστε να μην 
χρειάζεται ο χρήστης να κοιτάζει χαμηλά στην οθόνη για να τις δει. Το εργαλείο αυτό 
αποτελεί επίσης μια ακόμα μέθοδο για εισαγωγή αποστάσεων  και κατευθύνσεων. Το 
εργαλείο αυτό ενεργοποιείται κάνοντας κλικ στο εργαλείο   Dynamic Input που 
βρίσκεται στη γραμμή κατάστασης. 

2.5.3 Επιλογή των μανάδων σχεδίασης 

Είναι αναγκαίο σε κάποια φάση της σχεδίασης να γίνει ρύθμιση των μονάδων στο 
AutoCAD. Το σύστημα που χρησιμοποιείται ευρέος στην Ελλάδα είναι το μετρικό 
(Metric) σύστημα μονάδων μέτρησης, με μέτρα (m).  

Για την επιλογή μιας μονάδας σχεδίασης, χρησιμοποιούνται οι επιλογές του τμήματος 
Insertion scale στο παράθυρο διαλόγου Drawing Units. Αυτό εμφανίζεται κάνοντας 
κλικ στο μενού εφαρμογή, έπειτα στο Drawing Utilities και στην συνέχεια στο Units. 
Επίσης στο παράθυρο διαλόγου Drawing Units (εικόνα 2.18).μπορεί κανείς να βρει 
και άλλες επιλογές, οι κυριότερες των οποίων φαίνονται στον πίνακα 2.2. 

 

Εικόνα 2.18 - Το παράθυρο διαλόγου Drawing Units 
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2.5.4 Όρια περιοχής σχεδίασης 

Μια σημαντική έννοια που πρέπει να γνωρίζει ο χρήστης είναι ότι η περιοχή 
σχεδίασης του AutoCAD είναι ουσιαστικά απεριόριστη. Μπορεί να συμπεριλάβει 
σχεδόν τα πάντα σε ένα μόνο σχέδιο. Έχοντας όμως στη διάθεση του ο χρήστης αυτή 
την απεριόριστη περιοχή για να εργαστεί, πρέπει να ξέρει ότι μπορεί να ορίσει κάποια 
οπτικά όρια. 

Για να οριστούν τα όρια σχεδίου, πληκτρολογείται limits στη γραμμή εντολών και 
Enter. Μετά πάλι Enter υποδηλώνοντας ότι τα όρια αρχίζουν από το σημείο 0,0. Για 
να οριστούν οι συντεταγμένες της απέναντι άκρης του ορθογωνίου της περιοχής 
ορίων πληκτρολογείται για παράδειγμα 100’50’ όπου ορίζεται 100 μονάδες στον 
άξονα X και 50 στον άξονα Y.  

Precision 
 

αυτή η επιλογή επιτρέπει στον χρήστη να ελέγχει τον τρόπο με τον 
οποίο το AutoCAD αναφέρει τις τιμές μηκών και γωνιών και δεν 
επηρεάζει την ακρίβεια των αντικειμένων στο σχέδιο 

Direction 
 

το AutoCAD εξ ορισμού θεωρεί ότι 0° είναι μια οριζόντια 
κατεύθυνση από αριστερά προς τα δεξιά και οι 90° είναι η 
κατακόρυφη διεύθυνση. Οι τιμές γωνίας αυξάνονται από 0° και 
κινούνται αριστερόστροφα. Αν το σχέδιο απαιτεί διαφορετική 
κατεύθυνση για την αρχή του (0°), μπορεί να επιλεγεί η επιλογή 
Direction και να εμφανιστεί το παράθυρο διαλόγου Direction. 
Μέσα στο παράθυρο διαλόγου υπάρχουν τέσσερα κουμπιά για την 
επιλογή της κατεύθυνσης του 0°. Στην περίπτωση που δεν 
συμβαδίζει με τις βασικές κατευθύνσεις μπορεί να οριστεί μια 
γωνία επιλέγοντας τη ρύθμιση Other 

Clockwise 
 

οι γωνίες εξ ορισμού αυξάνονται αριστερόστροφα, αλλά μπορεί να 
γίνει επιλογή δεξιόστροφης αύξηση επιλέγοντας Clockwise από 
την ομάδα Angle 

 

Πίνακας 2.2 - Οι επιλογές του παράθυρου διαλόγου Drawing Units 

2.5.5 Χρήση ψηφιακού οργάνου Τ και τριγώνου 

Πριν κυκλοφορήσουν τα συστήματα CAD, στα γραφεία των σχεδιαστών, υπήρχαν το 
όργανο Τ και τα τρίγωνα, τα οποία χρησιμοποιούνταν για την σχεδίαση οριζόντιων 
και κάθετων γραμμών. Το AutoCAD παρέχει δύο στοιχεία που εκτελούν την ίδια 
λειτουργία με αυτά, την κατάσταση Ortho και Polar Tracking.  

2.5.5.1 Η κατάσταση Ortho 

Η κατάσταση Ortho είναι παρόμοια με την χρήση ενός T και αναγκάζει τον δρομέα 
να κινείται σε κάθετη και οριζόντια διεύθυνση. Μπορεί να γίνει με δύο τρόπους, όπου 
ο πρώτος συναντάται σε πολλά σχεδιαστικά προγράμματα και είναι κρατώντας το 
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πλήκτρο Shift ενώ επιλέγονται σημεία. Ο δεύτερος τρόπος είναι κάνοντας κλικ στο 
κουμπί Ortho στη γραμμή κατάστασης του AutoCAD για να ενεργοποιηθεί η 
κατάσταση Ortho. Αφού ενεργοποιηθεί η κατάσταση, ο δρομέας θα κινείται συνεχώς 
σε οριζόντια ή κάθετη διεύθυνση.  

2.5.5.2 Η κατάσταση Polar Tracking 

Ένα άλλο εργαλείο που μοιάζει με το Τ σχεδιαστών είναι το polar tracking. Όπως θα 
φανεί όμως, το Polar Tracking είναι πολύ πιο ευέλικτο από το Ortho επειδή δεν 
υποχρεώνει το δρομέα να κινείται σε απόλυτα οριζόντιες ή κάθετες διευθύνσεις. 
Αντίθετα, προκαλεί την  «έλξη» του δρομέα σε οριζόντιο ή κάθετο προσανατολισμό 
όταν ο δρομέας  πλησιάζει μια τέτοια διεύθυνση. 

Το Polar Tracking μπορεί  να ενεργοποιηθεί κάνοντας κλικ στο κουμπί  Polar 
Tracking στη γραμμή κατάστασης του AutoCAD. Δεν περιορίζεται όμως σε 
οριζόντιες και κάθετες διευθύνσεις γιατί μπορεί να οριστεί το  Polar Tracking έτσι 
ώστε να «έλκεται»  σε οποιαδήποτε γωνία όπως περίπου ένα ρυθμιζόμενο τρίγωνο 
όταν γίνεται σχεδίαση με το χέρι. 

Μπορεί να αλλάξει η συμπεριφορά του Polar Tracking από το παράθυρο διαλόγου  
Drafting Settings. Το παράθυρο αυτό εμφανίζεται κάνοντας δεξί κλικ στο εργαλείο 
Polar Tracking  στη γραμμή της κατάστασης για να ανοίξει το μενού συντόμευσης 
και κατόπιν κάνοντας κλικ στην επιλογή Settings. 

2.5.6 Επιλογή ακριβών θέσεων σε αντικείμενα 

Ένας από τους βασικούς λόγους που χρησιμοποιείται το AutoCAD είναι ότι δίνει τη 
δυνατότητα να δημιουργηθούν αναπαραστάσεις των σχεδίων με μεγάλη ακρίβεια.Ένα 
από τα πιο σημαντικά εργαλεία που χρησιμοποιείται για τη σχεδίαση με ακρίβεια 
είναι τα σημεία έλξης  σε αντικείμενα , τα  object snaps ή αλλιώς osnaps. 



ΚΕΦΑΛΑΙΟ 2: ΤΟ ΣΧΕΔΙΑΣΤΙΚΟ ΠΡΟΓΡΑΜΜΑ AUTOCAD 

 
 

ΚΟΝΤΑΞΗΣ Α. – ΠΑΡΑΔΕΙΣΗΣ Γ.  24 
 

 

Εικόνα 2.19 - Το παράθυρο διαλόγου Drafting Settings στην καρτέλα Object 
Osnaps 

Τα osnaps είναι δηλαδή ένας τρόπος επιλογής θέσεων με ακρίβεια πάνω σε 
υπάρχοντα αντικείμενα σε ένα σχέδιο, όπως μια άκρη ή το μέσο μια γραμμής ή την 
τομή μια γραμμής και ενός κύκλου. Η ενεργοποίησης της κατάστασης Osnaps γίνεται 
κάνοντας κλικ στο εργαλείο Object Snap στη γραμμή κατάσταση. 

Μπορούν να οριστούν τα σημεία έλξης τα οποία ενδιαφέρουν πιο πολύ το χρήστη 
κάνοντας δεξί κλικ στο εργαλείο Object Snap στη γραμμή κατάστασης, ώστε να 
ανοίξει το μενού συντόμευσης και κατόπιν επιλέγοντας Settings. Αμέσως ανοίγει το 
παράθυρο διαλόγου Drafting Settings (εικόνα 2.19) το οποίο έχει αρκετές επιλογές με 
πιο χρήσιμες αυτές του πίνακα 2.3. 

Μια άλλη πολύ βοηθητική λειτουργία του AutoCAD που έχει να κάνει με τα Osnaps 
είναι η στοίχιση αντικειμένων. Η λειτουργία Object Snap Tracking ή αλλιώς Osnap 
Tracking (ρέοντα σημεία έλξης), είναι μια επέκταση των Object Snaps, η οποία 
επιτρέπει την στοίχιση σε ένα σημείο στη γεωμετρία ενός αντικειμένου και όχι πάνω 
στο αντικείμενο. Η ενεργοποίηση της κατάστασης Osnaps Tracking γίνεται κάνοντας 
κλικ στο εργαλείο Object Snap Tracking στη γραμμή κατάσταση. 
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Όπως και με τα σημεία έλξης, έτσι και με τα ρέοντα σημεία έλξης, μπορούν να 
οριστούν από τον χρήστη αυτά που τον ενδιαφέρουν κάνοντας δεξί κλικ στο εργαλείο 
Object Snap Tracking στη γραμμή κατάστασης για να ανοίξει το μενού συντόμευσης 
και κατόπιν επιλέγοντας Settings. Αμέσως ανοίγει το παράθυρο διαλόγου Drafting 
Settings (εικόνα 2.19). Το παράθυρο που ανοίγει είναι το ίδιο με των Osnaps γιατί οι 
επιλογές είναι κοινές. Όπως προαναφέρθηκε οι πιο σημαντικές επιλογές βρίσκονται 
στον πίνακα 2.3.  

 
Center 

 

επιλέγει το κέντρο ενός τόξου ή ενός κύκλου. Πρέπει να γίνεται 
κλικ στο τόξο ή στον κύκλο και όχι στο προφανές κέντρο 
 

 
Endpoint 

 επιλέγει όλα τα άκρα των γραμμών, των τόξων και των καμπύλων 

 
Extension 

 

επιλέγει ένα σημείο που ευθυγραμμίζεται με τη νοητή επέκταση 
μιας γραμμής 
 

 Midpoint επιλέγει το μέσο μιας γραμμής ή ενός τόξου 

 

Πίνακας 2.3 - Οι επιλογές για τα osnaps 

2.5.7 Η κατάσταση πλέγματος 

Σχεδόν όλοι έχουν δει ή χρησιμοποιήσει χαρτί μιλιμετρέ (με πλέγμα). Αυτό το 
σημαντικό βοήθημα υπάρχει και στα προγράμματα CAD, τα οποία βοηθούν στην 
ορθότερη αντίληψη των αναλογιών και των αποστάσεων όταν δεν υπάρχει κλίμακα.  

Η κατάσταση Grid του AutoCAD προβάλλει έναν πίνακα μη εκτυπώσιμων τελείων 
μέσα στα όρια της περιοχής σχεδίασης. Η απόσταση μεταξύ των τελειών μπορεί να 
οριστεί από τον χρήστη. Είναι εφικτή η εμφάνιση και η εξαφάνιση τους κάνοντας 
κλικ στο εργαλείο Grid Display στη γραμμή κατάστασης. 

2.5.7.1 Έλξη στο πλέγμα ή σε άλλα ίσα διαστήματα 

Ανάλογα με το τύπο του σχεδίου που δημιουργείται, μπορεί να αποβεί χρήσιμο ο 
δρομέας να «έλκεται» από το πλέγμα ή από άλλα ίσα διαστήματα. Αυτό γίνεται με 
την κατάσταση Snap του  AutoCAD. 

Για την ενεργοποίηση της κατάστασης  Snap, πρέπει να γίνει κλικ στο εργαλείο  Snap  
Mode στη γραμμή κατάστασης . Εξ’ ορισμού , η απόσταση των σημείων πλέγματος 
και έλξης είναι η ίδια. Εάν επομένως ενεργοποιηθεί ταυτόχρονα το πλέγμα και η 
έλξη, ο δρομέας φαίνεται ότι έλκεται από τα σημεία του πλέγματος. Μπορεί αν είναι 
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επιθυμητό να οριστούν δύο διαστάσεις με διαφορετικές τιμές χρησιμοποιώντας το 
παράθυρο διαλόγου  Drafting Settings, το οποίο μπορεί να εμφανιστεί κάνοντας δεξί 
κλικ στο εργαλείο  Grid Mode ή  Snap Mode στη γραμμή κατάστασης και 
επιλέγοντας  Settings από το μενού συντόμευσης (εικόνα 2.20) 

 

Εικόνα 2.20 - Το παράθυρο διαλόγου Drafting Settings στην καρτέλα Snap and 
Grid 

2.6 Σχεδίαση διαστάσεων (2D)  αντικειμένων. 

Όλα όσα θα σχεδιαστούν στο AutoCAD είναι αντικείμενα δύο διαστάσεων και για το 
λόγο αυτό πρέπει να είναι γνωστά πολύ καλά τα διάφορα εργαλεία  και ο τρόπος 
χρήσης τους. Ο πίνακας  Draw της καρτέλας  Home, χρησιμοποιείται αρκετά συχνά 
έχοντας τα πολύ σημαντικά σχεδίασης ευθειών γραμμών, κύκλων και τόξων. Ο 
πίνακας  Draw μπορεί να αναπτυχθεί κάνοντας κλικ στη γραμμή τίτλου του πίνακα. 
Επίσης ένα άλλο πολύ σημαντικό εργαλείο για σχεδίαση, είναι το εργαλείο σχεδίασης 
παράλληλων γραμμών, το οποίο βρίσκεται στο πίνακα  Modify της ίδιας καρτέλας. 
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2.6.1 Σχεδίαση ευθειών γραμμών 

Το βασικό εργαλείο στο AutoCAD, όπως σε κάθε πρόγραμμα CAD, είναι η γραμμή. 
Ο σχεδιασμός μιας γραμμής γίνεται κάνοντας κλικ στο εργαλείο  Line του πίνακα  
Draw της καρτέλας  Home (εικόνα  2.21) 

Όταν σχεδιάζεται μια σειρά συνεχόμενων ευθύγραμμων τμημάτων με την εντολή   
Line, κάθε ευθύγραμμο τμήμα συμπεριφέρεται ως ξεχωριστό αντικείμενο και έτσι 
είναι εφικτή η μετακίνηση των τμημάτων ξεχωριστά. 

 

Εικόνα 2.21 - Το παράθυρο διαλόγου Line του πίνακα Draw της καρτέλας Home 
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2.6.2 Σχεδίαση ορθογωνίων 

 

Εικόνα 2.22 - Το παράθυρο διαλόγου Rectangle του πίνακα Draw της καρτέλας 
Home 

Μετά τη γραμμή, τα ορθογώνια είναι τα πιο εύκολα αντικείμενα που μπορούν να 
σχεδιαστούν. Για τον σχεδιασμό ενός ορθογωνίου γίνεται κλικ στο εργαλείο  
Rectangle του πίνακα Draw της καρτέλας  Home (εικόνα  2.22). Στην συνέχεια 
κάνοντας κλικ σε δύο σημεία στην περιοχή σχεδίασης σχηματίζεται το επιθυμητό 
παραλληλόγραμμο. Αυτό μπορεί επίσης να γίνει πληκτρολογώντας τις συντεταγμένες 
δύο απέναντι γωνιών του παραλληλογράμμου στη γραμμή εντολών. 

2.6.3 Σχεδίαση κύκλων 

Όπως όλα τα πράγματα στο    AutoCAD, έτσι και οι κύκλοι προσφέρουν ένα ευρύ 
φάσμα επιλογών. Κάνοντας κλικ στο τριγωνικό βέλος δίπλα στο εργαλείο  Circle 
στον πίνακα  Draw της καρτέλας  Home εμφανίζονται κάποιες επιλογές (εικόνα 2.23) 
όσον αγορά την σχεδίαση ενός κύκλου με τις πιο χρήσιμες τις επιλογές  Center, 
Radius και Center Diameter. Επιλέγοντας την επιλογή  Center, Radius και κάνοντας 
κλικ στη περιοχή σχεδίασης, ορίζεται η επιθυμητή θέση του κέντρου του κύκλου. 
Έπειτα κάνοντας κλικ σε ένα άλλο σημείο δηλώνεται η ακτίνα του. Μπορεί επίσης να 
πληκτρολογηθεί η τιμή της ακτίνας του κύκλου στη γραμμή εντολών και  Enter. 

Επιλέγοντας την επιλογή  Center, Diameter και κάνοντας κλικ στη περιοχή σχεδίαση, 
ορίζεται και πάλι η επιθυμητή θέση του κέντρου του κύκλου. Έπειτα κάνοντας κλικ 
σε ένα σημείο δηλώνεται η διάμετρος του. Όπως και προηγουμένως, μπορεί να 
πληκτρολογηθεί η τιμή της ακτίνας του κύκλου στη γραμμή εντολών και Enter. 
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Εικόνα 2.23 - Οι επιλογές του εργαλείου Circle του πίνακα Draw της καρτέλας 
Home 

 

2.6.4 Σχεδίαση τόξων 

Κάνοντας κλικ στο τριγωνικό βέλος δίπλα στο εργαλείο Arc  στον πίνακα Draw της 
καρτέλας  Home (εικόνα 2.24) εμφανίζονται κάποιες επιλογές όσον αφορά την 
σχεδίαση ενός τόξου με πιο χρήσιμη την επιλογή  3-Point.    

Επιλέγοντας την επιλογή 3-Point και κάνοντας τρία κλικ σε διαφορετικά σημεία στην 
περιοχή σχεδίαση, οριζόνται τρία σημεία που θα περνά το τόξο. Το πρώτο και το 
τελευταίο σημείο είναι το σημείο αρχής και τέλους του τόξου αντίστοιχα. 
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Εικόνα 2.24 - Η επιλογή 3-Point του εργαλείου Arc του πίνακα Draw  

2.6.5 Εισαγωγή κειμένου 

Η εισαγωγή κειμένου μέσα στην περιοχή σχεδίασης γίνεται κάνοντας κλικ στο 
τριγωνικό βέλος του εργαλείου Multiline Text  του πίνακα  Annotation   της καρτέλας 
Home  (2.25).   

 

Εικόνα 2.25 - Το εργαλείο Single Line   του πίνακα  Annotation   της καρτέλας 
Home 

Εκεί υπάρχουν δύο εργαλεία ,το Multiline Text  και το Single Line.Και τα δύο 
εργαλεία είναι χρήσιμα αλλά  πιο εύκολο στην χρήση είναι το     Single Line .Αφού 
γίνει η επιλογή  Single Line   γίνεται κλικ στην περιοχή σχεδίασης για να οριστεί η 
αρχή του κειμένου .Μετά γίνεται το δεύτερο κλικ σε άλλο σημείο για να οριστεί το 
ύψος των  γραμμάτων και  με ένα τρίτο κλικ ορίζεται μια γωνία για την κλίση του 
κειμένου. Φυσικά όλα τα μεγέθη μπορούν να δοθούν πληκτρολογώντας την τιμή τους 
στην γραμμή εντολών.  
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2.6.6  Σχεδίαση παράλληλων γραμμών 

Μια άλλη πολύ χρήσιμη λειτουργία του   AUTOCAD  είναι η σχεδίαση παράλληλων 
γραμμών . Αυτό είναι εφικτό με την εντολή Offset. Η εντολή Offset δημιουργεί 
παράλληλα αντίγραφα αντικειμένων και είναι πιο ευέλικτος τρόπος σχεδίασης 
παράλληλων γραμμών. 

Για να χρησιμοποιηθεί η εντολή Offset γίνεται κλικ στο εργαλείο Offset στον πίνακα 
Modify της καρτέλας Home (εικόνα 2.26). Στην συνέχεια υποδεικνύεται η απόσταση 
που θα έχουν οι παράλληλες γραμμές με την πληκτρολόγηση της τιμή της στη 
γραμμή εντολών ή επιλέγοντας δύο σημεία στην περιοχή σχεδίασης με δύο κλικ. 

Μετά επιλέγεται το αντικείμενο ή η γραμμή που θα αντιγραφεί και κατόπιν ορίζεται 
σε ποια μεριά του αντικειμένου είναι επιθυμητό να εμφανίζεται το αντίγραφο, απλά 
κάνοντας κλικ στην αντίστοιχη μεριά στην περιοχή σχεδίασης. 

 

Εικόνα 2.26 - Το Εργαλείο Offset του πίνακα Modify της καρτέλας Home 

 

2.7 Επεξεργασία αντικειμένων στο AutoCAD 

Πολύ σημαντικά εφόδια στο σχεδιασμό ενός σχεδίου στο AutoCAD , είναι η γνώση 
της επιλογής , της διαγραφής , της μετακίνησης ,της αντιγραφής, της περιστροφής και 
της κλιμάκωσης ενός ή πολλών αντικειμένων. 

2.7.1 Επιλογή αντικειμένων με παράθυρα 

Η επιλογή αντικειμένων γίνεται κάνοντας κλικ σε αυτά ή κάνοντας κλικ σε μια κενή 
περιοχή ,ώστε να σχηματιστεί ένα παράθυρο επιλογής .Στην περίπτωση που επιλεγεί 
ένα σημείο και συρθεί το ποντίκι διαγώνια αριστερά επιλέγοντας μια περιοχή 
αντικειμένων , τότε το παράθυρο θα εμφανίζεται με στικτές γραμμές και θα είναι 
πράσινο .Σε αυτή την περίπτωση επιλέγονται όλα τα αντικείμενα που 
διασταυρώνονται με το παράθυρο ( εικόνα 2.27 αριστερά ). 

Στην άλλη περίπτωση που επιλέγεται ένα σημείο και σύροντας το ποντίκι διαγώνια 
δεξιά επιλέγεται μια περιοχή αντικειμένων , τότε το παράθυρο θα εμφανίζεται με μια 
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συνεχή μπλε γραμμή. Σε αυτή την περίπτωση επιλέγονται τα αντικείμενα που 
περιλαμβάνονται εξ ολοκλήρου μέσα στο παράθυρο ( εικόνα 2.27 δεξιά).  

 

 

Εικόνα 2.27 – Η περίπτωση που σύρετε το ποντίκι αριστερά (αριστερά) και η 
περίπτωση που σύρετε το ποντίκι δεξιά (δεξιά) 

2.7.2 Διαγραφή αντικειμένου 

Στο AutoCAD μπορεί να γίνει διαγραφή αντικειμένων με διάφορους τρόπους. 
Μπορεί να χρησιμοποιηθεί το εργαλείο Erase στον πίνακα Modify της καρτέλας 
Home (εικόνα 2.28) και στη συνέχεια να επιλεγεί το αντικείμενο που θα διαγραφεί. 
Μπορεί επίσης να επιλεχθούν ένα ή πολλά αντικείμενα και να πατηθεί το πλήκτρο 
Delete. 
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Εικόνα 2.28 – Το Εργαλείο Erase του πίνακα Modify της καρτέλας Home 

 

2.7.3 Μετακίνηση αντικειμένου 

Για τη μετακίνηση των αντικειμένων μπορεί να χρησιμοποιηθεί η εντολή Move 
κάνοντας κλικ στο εργαλείο Move του πίνακα Modify της καρτέλας Home (εικόνα 
2.29) ή απλά επιλέγοντας το αντικείμενο με ένα κλικ και με ένα δεύτερο κλικ πάνω 
στο αντικείμενο, το αντικείμενο σύρεται εκεί που επιθυμείται. 

 

Εικόνα 2.29 – Το Εργαλείο Move του πίνακα Modify της καρτέλας Home 
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2.7.4 Αντιγραφή αντικειμένου 

Η αντιγραφή των αντικειμένων γίνεται χρησιμοποιώντας την εντολή Copy κάνοντας 
κλικ στο εργαλείο Copy του πίνακα Modify της καρτέλας Home (εικόνα 2.30). Όπως 
και στα Windows , έτσι και στο AutoCAD μπορεί να γίνει επιλογή ενός αντικειμένου 
και με τα πλήκτρα ctrl+c γίνεται αντιγραφή του αντικειμένου. Στην συνέχεια με τα 
πλήκτρα ctrl+v  γίνεται επικόλληση του αντικειμένου στην επιθυμητή θέση. Η 
αντιγραφή και η μετακίνηση αντικειμένων μπορεί να γίνει επίσης επιλέγοντας το ή τα 
αντικείμενα και κάνοντας δεξί κλικ, όπου και πάλι εμφανίζονται οι επιλογές Copy και 
Move. 

 

Εικόνα 2.30 – Το Εργαλείο Copy του πίνακα Modify της καρτέλας Home 

2.7.5 Περιστροφή αντικειμένου 

Για την περιστροφή ενός ή πολλών αντικειμένων, χρησιμοποιείται η εντολή Rotate. 
Αυτό γίνεται κάνοντας κλικ στο εργαλείο Rotate  από τον πίνακα Modify  της 
καρτέλας Home (εικόνα 2.31). Στη συνέχεια επιλέγεται το αντικείμενο που θα 
περιστραφεί και Enter. Μετά επιλέγεται ένα σημείο για να οριστεί ο άξονας 
περιστροφής και πληκτρολογείται μια τιμή γωνίας στη γραμμή εντολών και πάλι 
Enter. 
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Εικόνα 2.31 – Το Εργαλείο Rotate του πίνακα Modify της καρτέλας Home 

2.7.6 Κλιμάκωση αντικειμένου 

Για την αλλαγή του μεγέθους ενός ή πολλών αντικειμένων χρησιμοποιείται η εντολή 
Scale. Αυτό γίνεται κάνοντας κλικ στο εργαλείο Scale  από τον πίνακα Modify της 
καρτέλας Home (εικόνα 2.32). 

Μετά επιλέγοντας το ή τα αντικείμενα που θα κλιμακωθούν και Enter. 

Στη συνέχεια επιλέγεται ένα σημείο πάνω στην περιοχή σχεδίασης από όπου θα γίνει 
η κλιμάκωση και έπειτα πληκτρολογείται μια τιμή κλιμάκωσης στη γραμμή εντολών 
και πάλι Enter. 

 

Εικόνα 2.32 – Το Εργαλείο Scale του πίνακα Draw της καρτέλας Home 
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2.8 Οργάνωση με τα επίπεδα 

Το εργαλείο που χρησιμοποιείται πιο συχνά για την καλύτερη οργάνωση στο 
AutoCAD είναι η διαστρωμάτωση σε επίπεδα (Layers). Τα επίπεδα επιτρέπουν την 
ταξινόμηση μερών του σχεδίου σε κατηγορίες. Για παράδειγμα σε μια τυπική κάτοψη 
οικίας σε αρχιτεκτονικό σχέδιο, μπορεί να υπάρχει ένα επίπεδο για τους τοίχους, ένα 
άλλο για τις πόρτες και ακόμα ένα για τις ντουλάπες. 

Μπορεί να γίνει η εμφάνιση και η εξαφάνιση των επιπέδων , ώστε να 
περιλαμβάνονται στο σχέδιο μόνο τα δεδομένα που χρειάζονται κάθε στιγμή. Μπορεί 
να γίνει καθορισμός του χρώματος, του τύπου και του πάχους γραμμών στα επίπεδα 
και τα αντικείμενα θα αποκτούν τις ιδιότητες του κάθε επιπέδου. 

2.8.1 Δημιουργία, ενεργοποίηση/απενεργοποίηση και εναλλαγή 
επιπέδων 

Για την δημιουργία νέου επιπέδου ή για την επεξεργασία τους, χρησιμοποιείται το 
παράθυρο διαλόγου Layer Properties Manager. Για να εμφανιστεί αυτό το παράθυρο 
γίνεται κλικ στο εικονίδιο Layer Manager (εικόνα 2.33) στον πίνακα Layers της 
καρτέλας Home. 

 

Εικόνα 2.33 – Το κουμπί για το παράθυρο διαλόγου Layer Properties Manager 

Στη συνέχεια γίνεται κλικ στο εργαλείο New Layer (εικόνα 2.34) στο πάνω μέρος του 
παραθύρου και ένα νέο επίπεδο με το όνομα Layer1 εμφανίζεται στο πλαίσιο λίστας. 
Το όνομα τονίζεται ώστε να μπορεί να δοθεί αμέσως ένα όνομα σε αυτό. Με το 
όνομα του επιπέδου τονισμένο μπορεί να γίνουν κάποιες ρυθμίσεις σε αυτό, όπως το 
χρώμα του (εικόνα 2.35) , τον τύπο και το πάχος γραμμής του. 
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Εικόνα 2.34 – Το παράθυρο διαλόγου Layer Properties Manager 

Κάτι άλλο που μπορεί να ρυθμιστεί μέσω του παραθύρου διαλόγου Layer Properties 
Manager, είναι η εμφάνιση και μη των επιπέδων. Έχοντας επιλέξει ένα επίπεδο και 
κάνοντας κλικ σε εικονίδιο με τη λάμπα, το εικονίδιο γίνεται από κίτρινο γκρι. Αυτό 
δηλώνει ότι το επίπεδο τώρα δεν είναι ορατό και όλα τα αντικείμενα τα οποία 
σχεδιάστηκαν στο συγκεκριμένο επίπεδο που επιλέχθηκε εξαφανίζονται. 

Κάποιες από τις επιλογές που υπάρχουν στο παράθυρο διαλόγου Layer Properties 
Manager, (εκτός από την δημιουργία νέου επιπέδου), υπάρχουν και στην λωρίδα 
εργαλείων του AutoCAD, στον πίνακα Layers της καρτέλας Home. Κάτι άλλο πολύ 
σημαντικό που μπορεί να γίνει από τη λωρίδα εργαλείων του AutoCAD είναι η 
εναλλαγή των επιπέδων. Αυτό γίνεται πολύ απλά κάνοντας κλικ στο τριγωνικό βέλος 
στο εργαλείο Layer του ίδιου πίνακα. Η λίστα μεγαλώνει και εμφανίζονται όλα τα 
επίπεδα του σχεδίου, επιλέγοντας αυτό που είναι επιθυμητό.  
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Εικόνα 2.35 - Η αλλαγή του χρώματος του επιπέδου στο παράθυρο διαλόγου 
Layer Properties Manager 

Μετά την ενημέρωση του αναγνώστη για τα επίπεδα είναι σκόπιμο τώρα να 
αναφερθούν οι διάφορες ρυθμίσεις που μπορούν να γίνουν πριν χρησιμοποιηθεί 
οποιοδήποτε εργαλείο για τον σχεδιασμό ενός αντικειμένου. Δεν έχει σημασία τι 
ρυθμίσεις έχει την στιγμή που θα αποθηκευτεί το αντικείμενο ή το σύμβολο. Σημασία 
έχει το τι ρυθμίσεις έχει τη στιγμή της δημιουργίας του, δηλαδή την στιγμή που θα 
χρησιμοποιείται ένα εργαλείο σχεδίασης για παράδειγμα το Line. Αυτές οι ρυθμίσεις 
είναι σημαντικές για ένα αντικείμενο και βρίσκονται στον πίνακα Properties της 
καρτέλας Home (εικόνα 2.36). Όπως πάντα στο AutoCAD οι επιλογές αυτές μπορούν 
να αλλάξουν οποιαδήποτε στιγμή επιθυμεί ο χρήστης. Αναφέρονται σχετικά με το 
χρώμα (Object Color), το πάχος (Lineweight) και τον τύπο (Linetype) την γραμμής 
που θα έχει το αντικείμενο. Οι επιλογές που υπάρχουν και για τα τρία αυτά 
χαρακτηριστικά είναι τρεις. Πρώτη επιλογή είναι Το ByLayer, δεύτερη επιλογή είναι 
το ByBlock και τρίτη επιλογή είναι ένα συγκεκριμένο είδος για παράδειγμα κόκκινο 
για χρώμα ή 0,20mm για πάχος ή διακεκομμένη γραμμή για τύπο.  

Ανάλογα με τι επιλογές θα γίνουν στις ρυθμίσεις, θα προκύψουν και οι ανάλογες 
συμπεριφορές των αντικειμένων όταν αυτά εισάγονται σε άλλα επίπεδα που έχουν 
και αυτά τις δικές τους ρυθμίσεις. 
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Εικόνα 2.36 - Οι ρυθμίσεις του πίνακα Properties της καρτέλας Home 

Ο σχεδιασμός των ηλεκτρικών συμβόλων γίνεται στο επίπεδο 0 και με ρυθμίσεις (και 
για τα τρία χαρακτηριστικά), ByLayer. Ο λόγος που γίνεται αυτό είναι για να 
παίρνουν τα σύμβολα τις ρυθμίσεις του επιπέδου στο οποίο θα εισαχθούν, με 
κυριότερη ρύθμιση το χρώμα, αφού αυτό μόνο θα αλλάζει σε κάθε διαφορετικό 
επίπεδο. Σημαντικό είναι το ότι αν τα σύμβολα σχεδιαστούν σε άλλο επίπεδο εκτός 
του επιπέδου 0 τότε θα διατηρούν τις ρυθμίσεις του επιπέδου στο οποίο 
δημιουργήθηκαν και όπως αναφέρθηκε πιο πριν, αυτό θα ήταν ανεπιθύμητο στην 
περίπτωση που θα εισαχθούν σε ένα άλλο επίπεδο με διαφορετικά χαρακτηριστικά 

2.9 Σχεδιάζοντας στο AutoCAD (3D) 

Η δυνατότητα σχεδίασης σε τρεις διαστάσεις είναι ένα από τα σημαντικότερα 
πλεονεκτήματα του CAD. Η μετάβαση από τις δύο στις τρεις διαστάσεις γίνεται στο 
AutoCAD σχετικά εύκολα. Για παράδειγμα, εκτός από τις εντολές Array, Mirror και 
Rotate, οι οποίες γίνονται 3DArray, Mirror3D και Rotate3D αντίστοιχα, όλες οι άλλες 
λειτουργούν με τον ίδιο ακριβώς τρόπο και για τα τρισδιάστατα αντικείμενα. 

2.9.1 Συντεταγμένες 

Οτιδήποτε σχεδιάζεται στο AutoCAD είναι απόλυτα ακριβές. Όλα τα αντικείμενα 
τοποθετούνται στην περιοχή σχεδίασης σε σχέση με την αρχή ενός απλού 
συστήματος συντεταγμένων. Στο AutoCAD το προεπιλεγμένο σύστημα 
συντεταγμένων ονομάζεται WCS (World Coordinate System). Η αρχή του WCS 
βρίσκεται στο κάτω αριστερό άκρο της περιοχής σχεδίασης και οι άξονες είναι 
τοποθετημένοι έτσι ώστε η θετική κατεύθυνση του Χ να είναι παράλληλη με την 
οριζόντια πλευρά της οθόνης και προς τα δεξιά, ενώ η θετική κατεύθυνση του Υ να 
είναι παράλληλη με την κατακόρυφη πλευρά της οθόνης και προς τα πάνω. 
Υπενθυμίζεται ότι οι θετικές κατευθύνσεις των αξόνων δίνονται και από το εικονίδιο 
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του συστήματος συντεταγμένων. Η εισαγωγή ενός σημείου στο AutoCAD γίνεται 
είτε απευθείας επιλέγοντας ένα σημείο στην περιοχή σχεδίασης με το ποντίκι είτε 
πληκτρολογώντας τις συντεταγμένες του σημείου στην περιοχή εντολών. Συνίσταται 
να ακολουθείται σχεδόν πάντα ο δεύτερος τρόπος, αφού μόνο έτσι εξασφαλίζεται η 
ακριβής τοποθέτηση των σημείων και κατ’ επέκταση ο ακριβής σχεδιασμός. Όσον 
αφορά τις δύο διαστάσεις (σχήμα 2) υπάρχουν δύο διαφορετικά είδη συντεταγμένων, 
οι καρτεσιανές και οι πολικές συντεταγμένες.: 

1. Καρτεσιανές συντεταγμένες: πληκτρολογούνται δύο αριθμοί στη μορφή x,y ο 
καθένας από τους οποίους δηλώνει την απόσταση του σημείου από την αρχή του 
συστήματος συντεταγμένων ως προς κάθε άξονα. ΠΡΟΣΟΧΗ: Το κόμμα (,) 
χρησιμοποιείται για να χωρίζονται οι συντεταγμένες μεταξύ τους και η τελεία (.) για 
να δίνονται οι δεκαδικοί αριθμοί. 

2. Πολικές συντεταγμένες: πληκτρολογούνται δύο αριθμοί στη μορφή r<φ από τους 
οποίους το r δηλώνει την απόσταση του σημείου από την αρχή του συστήματος 
συντεταγμένων και το φ τη γωνία στροφής του. ΠΡΟΣΟΧΗ: Οι γωνίες μετρούνται 
θετικά ξεκινώντας από τον άξονα Οx, περιστρέφοντάς τον με φορά αντίθετη της 
φοράς των δεικτών του ρολογιού. 

Επειδή στους παραπάνω τρόπους εισαγωγής τα σημεία υπολογίζονται με βάση την 
αρχή του συστήματος συντεταγμένων, οι συντεταγμένες τους ονομάζονται απόλυτες. 
Αν όμως πριν από την αντίστοιχη μορφή χρησιμοποιηθεί το σύμβολο @ τότε οι 
συντεταγμένες ονομάζονται σχετικές και στην περίπτωση αυτή το νέο σημείο 
υπολογίζεται ως προς το αμέσως προηγούμενο σημείο που έχει εισαχθεί (σχήμα 3). 

Συνοψίζοντας, υπάρχουν τέσσερις συνολικά τρόποι για να εισάγουμε ένα σημείο στο 

AutoCAD πληκτρολογώντας τις συντεταγμένες του στην περιοχή εντολών: 

1. Με απόλυτες καρτεσιανές συντεταγμένες: x,y 

2. Με απόλυτες πολικές συντεταγμένες: r<φ 

3. Με σχετικές καρτεσιανές συντεταγμένες: @x,y 

4. Με σχετικές πολικές συντεταγμένες: @r<φ 

Όσα αναλύθηκαν σχετικά με τις συντεταγμένες στις δύο διαστάσεις ισχύουν, με την 
προσθήκη ενός επιπλέον άξονα (άξονας Z), ο οποίος δίνει την αίσθηση του ύψους 
στα αντικείμενα που σχεδιάζονται. Ο άξονας Z στο WCS βρίσκεται κατακόρυφα στο 
επίπεδο XY (επίπεδο της οθόνης) με θετική φορά προς το χρήστη, δηλαδή 
“βγαίνοντας” από την οθόνη προς τα έξω. Η θετική φορά των γωνιών στις τρεις 
διαστάσεις προσδιορίζεται με τη βοήθεια του κανόνα του δεξιού χεριού: κλείνοντας 
τα δάχτυλα του δεξιού χεριού γύρω από κάποιον άξονα, με τον αντίχειρα να δείχνει 
προς τη θετική κατεύθυνση του άξονα αυτού, η φορά κατά την οποία είναι διπλωμένα 
τα δάχτυλα ισοδυναμεί με τη θετική φορά περιστροφής γύρω από τον άξονα αυτό. 
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Ο τρόπος εισαγωγής των καρτεσιανών και των κυλινδρικών (αντί πολικών) 
συντεταγμένων τροποποιείται ως εξής: 

3. Καρτεσιανές συντεταγμένες: πληκτρολογούνται τρεις αριθμοί στη μορφή x,y,z ο 
καθένας από τους οποίους δηλώνει την απόσταση του σημείου από την αρχή του 
συστήματος συντεταγμένων ως προς κάθε άξονα. ΠΡΟΣΟΧΗ: Υπενθυμίζεται ότι το 
κόμμα (,) χρησιμοποιείται για να χωρίζονται οι συντεταγμένες μεταξύ τους και η 
τελεία (.) για να δίνονται οι δεκαδικοί αριθμοί. 

4. Κυλινδρικές συντεταγμένες: πληκτρολογούνται τρεις αριθμοί στη μορφή r<φ,z από 
τους οποίους το r δηλώνει την απόσταση του σημείου από την αρχή του συστήματος 
συντεταγμένων, το φ τη γωνία στροφής του ως προς τον άξονα X στο επίπεδο XY και 
το z την κατακόρυφη απόσταση του σημείου από το επίπεδο XY.  

Η διάκριση μεταξύ απόλυτων και σχετικών συντεταγμένων είναι ακριβώς η ίδια με 
τις δύο διαστάσεις, προσθέτοντας δηλαδή το σύμβολο @ πριν τις συντεταγμένες. 

Η προσθήκη του άξονα Z, επιτρέπει στο χρήστη να σχεδιάζει σε διαφορετικά επίπεδα 
ανύψωσης (elevation). Ενώ στις δύο διαστάσεις οποιοδήποτε αντικείμενο που 
σχεδιαζόταν ανήκε εξ ορισμού στο επίπεδο XY, στις τρεις διαστάσεις ο χρήστης έχει 
τη δυνατότητα να ορίσει μια προεπιλεγμένη συντεταγμένη Z, την οποία θα 
χρησιμοποιεί το AutoCAD όταν του δίνονται μόνο οι συντεταγμένες X, Y, μέσω της 
εντολής ELEVATION ή ELEV. Η εντολή ELEV επηρεάζει μόνο τα αντικείμενα που 
θα δημιουργηθούν ύστερα από την εισαγωγή της και η τιμή της επαναφέρεται 
αυτόματα ίση με το 0 κάθε φορά που ορίζεται ένα νέο σύστημα συντεταγμένων. 

2.9.2 Εργαλεία διερεύνησης (inquiry tools) 

Το AutoCAD προσφέρει μια ομάδα από εντολές που έχουν σκοπό να εξάγουν 
πληροφορίες από τα σχεδιασμένα αντικείμενα. Οι εντολές αυτές δε μεταβάλλουν το 
σχέδιο με κανένα τρόπο. Ο χρήστης έχει πρόσβαση στις εντολές αυτές από το μενού 
Tools → Inquiry. Οι εντολές αυτές είναι οι: 
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Όνομα Εντολής 
 

Πληκτρολόγηση 
Εντολής 

Αποτέλεσμα 
 

Distance DI / DIST Υπολογίζει την απόσταση και τη γωνία 
ανάμεσα σε 2 σημεία 

Area AREA Υπολογίζει το εμβαδόν και την 
περίμετρο αντικειμένων ή περιοχών 

Mass Properties MASSPROP 
 

Υπολογίζει τις μαζικές ιδιότητες 
περιοχών ή στερεών όπως όγκος, 
κέντρο βαρύτητας, ροπές αδρανείας 
κλπ 

List LI 
Εμφανίζει τα στοιχεία της βάσης 
δεδομένων του AutoCAD για ένα ή 
περισσότερα αντικείμενα 

ID ID Εμφανίζει τις συντεταγμένες ενός 
σημείου 

 

Πίνακας 11. Εντολές διερεύνησης. 

2.10 Μοντέλα στερεών (Solid models) 

Τα μοντέλα στερεών είναι η πιο εξελιγμένη φιλοσοφία σχεδίασης σε τρεις 
διαστάσεις. Τα αντικείμενα περιγράφονται από τις ακμές, τις επιφάνειες και τον όγκο 
τους και διαθέτουν όλα τα χαρακτηριστικά ενός πραγματικού αντικειμένου (μάζα, 
όγκο, κέντρο βάρους, κλπ). Το AutoCAD προσφέρει τρεις γενικούς τρόπους 
δημιουργίας στερεών αντικειμένων. Πρώτον, ανυψώνοντας (extrude) δισδιάστατα 
προφίλ αντικειμένων κατά τον άξονα Z ή κατά μήκος μιας ορισμένης από το χρήστη 
τροχιάς. Δεύτερον, περιστρέφοντας δισδιάστατα προφίλ αντικειμένων γύρω από έναν 
άξονα ή γύρω από μια ορισμένη από το χρήστη τροχιά. Και στις δύο αυτές 
περιπτώσεις πρέπει να τηρηθούν κάποιοι περιορισμοί για το πως έχουν δημιουργηθεί 
τα προφίλ αυτά. Τρίτον, μέσω της δημιουργίας κάποιων έτοιμων βασικών στερεών 
αντικειμένων που καλούνται πρωτογενή στερεά. 

Όπως είναι κατανοητό, οι δύο πρώτοι τρόποι εκμεταλλεύονται την ύπαρξη κάποιου 
είδους συμμετρίας στα στερεά αντικείμενα και μόνο τότε πρέπει να 
χρησιμοποιούνται. 

Υπενθυμίζεται ότι ανεξάρτητα από τον τρόπο με τον οποίο έχουν δημιουργηθεί τα 
μοντέλα στερεών, ο χρήστης μπορεί να αποκτήσει πρόσβαση στα φυσικά 
χαρακτηριστικά τους χρησιμοποιώντας τις εντολές διερεύνησης (inquiry tools) του 
AutoCAD που περιγράφηκαν σε προηγούμενη ενότητα. 
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2.11 Εντολές τροποποίησης διδιάστατων προφίλ 

Όνομα Εντολής 

 
Πληκτρολόγηση 

Εντολής 
 

Αποτέλεσμα 

Scale 
 

SCALE / SC 
 

Μεταβάλει το μέγεθος του(ων) 
επιλεγμένου(ων) αντικειμένου(ων) ή αν δεν 
έχει επιλεγεί κανένα ζητά από το χρήστη να 
επιλέξει το(α) αντικείμενο(α). Πρέπει να 
οριστεί ένα σημείο αναφοράς και η 
κλίμακα μεταβολής του μεγέθους (>1 
σημαίνει μεγέθυνση και <1 σημαίνει 
σμίκρυνση) 

Trim 
 TRIM / TR Κόβει αντικείμενα που τέμνονται μεταξύ 

τους, στα όρια των ακμών τομής 
Extend 

 EXTEND / EX Επεκτείνει ένα αντικείμενο μέχρι ένα όριο 

Chamfer 
CHAMFER / 

CHA 
 

Μεταβάλλει μια γωνιακή συναρμογή 
αποτέμνοντάς τη σε εκατέρωθεν 
αποστάσεις που ορίζονται από το χρήστη 

Fillet FILLET / F Μεταβάλλει μια γωνιακή συναρμογή σε 
συναρμογή ενός τόξου κύκλου 

 

Μερικές σημαντικές παρατηρήσεις/συμβουλές που αφορούν ορισμένες από τις 
εντολές τροποποίησης αντικειμένων: 

• Στην εντολή Trim, πρώτα επιλέγονται οι ακμές τομής και ύστερα το αντικείμενο 
που θα κοπεί. 

• Στην εντολή Extend, πρώτα επιλέγονται τα όρια επέκτασης και ύστερα το 
αντικείμενο που θα επεκταθεί. 

• Η εντολή Fillet θα τροποποιήσει το αντικείμενο μόνο αν η επιλεγμένη ακτίνα του 
τόξου είναι κατάλληλη. 

• Αν η εντολή Fillet εκτελεστεί για μια πολυγραμμή, τότε θα τροποποιηθούν όλα τα 
τμήματά της ταυτόχρονα. 

• Οι προηγούμενες δύο παρατηρήσεις ισχύουν και για την εντολή Chamfer. 
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2.12 Στερεά μέσω ανύψωσης (extruded solids) 

Η εντολή EXTRUDE (Extrude ή ext ή από το μενού Draw → Solids → Extrude) 
χρησιμοποιείται για να προσδώσει τη διάσταση του ύψους σε κάποιο αντικείμενο. 
Αυτό το αντικείμενο μπορεί να είναι οποιοδήποτε προφίλ μπορεί να αποτελείται από 
γραμμές, τόξα, πολυγραμμές, κλπ αρκεί να τηρείται η παρακάτω προϋπόθεση: 

Το προφίλ πρέπει να είναι κλειστό. Αυτό επιτυγχάνεται μετά τη σχεδίασή του 
χρησιμοποιώντας την εντολή PEDIT (Pedit ή από το μενού Modify → Object 
→Polyline) και ενεργοποιώντας την επιλογή Join. Επίσης, μπορεί να χρησιμοποιηθεί 
και η εντολή REGION (Region ή reg ή από το μενού Draw → Region). Και στις δύο 
περιπτώσεις, η αρχή και το τέλος του προφίλ πρέπει να είναι σημεία που συμπίπτουν 
και όχι το προφίλ να ορίζεται από γραμμές που τέμνονται σε κάποιο ενδιάμεσο 
σημείο τους. 

Η φορά της ανύψωσης μπορεί να οριστεί με δύο τρόπους, βλ. Σχήμα 5: 

1. Εισάγοντας μόνο την επιθυμητή τιμή του ύψους (height of extrusion). Το προφίλ 
ανυψώνεται κατά τη θετική κατεύθυνση του άξονα Z του UCS αν η τιμή είναι θετική 
και κατά την αρνητική κατεύθυνση του άξονα Z του UCS αν η τιμή είναι αρνητική. 

2. Επιλέγοντας ένα αντικείμενο (συνήθως μια γραμμή, ένα τόξο ή μια πολυγραμμή) 
που λειτουργεί ως τροχιά (path). 

Στην περίπτωση που επιλεγεί ο πρώτος τρόπος, ο χρήστης μπορεί να ορίσει αν το 
επιθυμεί και μια γωνία κωνικότητας (taper angle). 

 

Σχήμα 5. Ανύψωση (extrude) προφίλ κατά τον άξονα Z και κατά συγκεκριμένη 
τροχιά. 
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2.13 Στερεά μέσω περιστροφής (revolved solids) 

Η εντολή REVOLVE (Revolve ή rev ή από το μενού Draw → Solids → Revolve) 
χρησιμοποιείται για να περιστρέψει ένα αντικείμενο γύρω από έναν άξονα ή από μια 
τροχιά. Για το αντικείμενο αυτό ισχύουν οι ίδιοι ακριβώς περιορισμοί που 
περιγράφηκαν και για την εντολή της ανύψωσης.  

Ο χρήστης εκτός από την επιλογή του προφίλ και του αντικειμένου που ορίζει τον 
άξονα περιστροφής, καλείται να ορίσει και τη γωνία περιστροφής του προφίλ, βλ. 
Σχήμα 6. 

 

 

Σχήμα 6. Δημιουργία στερεού αντικειμένου εκ περιστροφής. 

 

2.14 Πρωτογενή στερεά (primitive solids) 

Εκτός από τους δύο προηγούμενους τρόπους δημιουργίας στερεών, το AutoCAD 
διαθέτει και συγκεκριμένους βασικούς τύπους έτοιμων στερεών αντικειμένων που 
μπορούν να χρησιμοποιηθούν. Τα αντικείμενα αυτά ονομάζονται πρωτογενή στερεά 
(primitive solids) και είναι τα παρακάτω, βλ. Σχήμα 7. 
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Όνομα Εντολής 
 

Πληκτρολόγηση 
Εντολής 

Αποτέλεσμα 
 

Box 
 BOX 

Δημιουργεί ένα ορθογώνιο 
παραλληλεπίπεδο ορίζοντας δύο σημεία 
της διαγωνίου του 

Sphere SPHERE Δημιουργεί μια σφαίρα ορίζοντας το 
κέντρο και την ακτίνα της 

Cylinder CYLINDER 
 

Δημιουργεί ένα κύλινδρο που μπορεί να 
έχει είτε κυκλική είτε ελλειπτική βάση. 
Πρέπει να οριστούν τα αντίστοιχα 
μεγέθη για τη δημιουργία της 
δισδιάστατης βάσης και στη συνέχεια το 
ύψος του κυλίνδρου 
 

Cone 
 

CONE 
 

Δημιουργεί έναν κώνο που μπορεί να 
έχει είτε κυκλική είτε ελλειπτική βάση. 
Πρέπει να οριστούν τα αντίστοιχα 
μεγέθη για τη δημιουργία της 
δισδιάστατης βάσης και στη συνέχεια το 
ύψος του κώνου 

Wedge 
 

WEDGE / WE 
 

Δημιουργεί μια σφήνα η βάση της οποίας 
βρίσκεται στο επίπεδο XY. Πρέπει να 
οριστούν οι διαστάσεις της βάσης της 
και στη συνέχεια το ύψος της 

Torus 
 

TORUS / TOR 
 

Δημιουργεί ένα τοροειδές ορίζοντας το 
κέντρο του, την ακτίνα του κύκλου που 
περνάει από το κέντρο της διατομής του 
και την ακτίνα της διατομής 
 

Πίνακας 13. Πίνακας πρωτογενών στερεών. 
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Σχήμα 7. Πρωτογενή στερεά. 

Τα πρωτογενή στερεά χρησιμοποιούνται στο AutoCAD με δύο τρόπους: 

• Είτε απευθείας για τη δημιουργία απλών τρισδιάστατων αντικειμένων ενός σχεδίου 
(π.χ. η βάση ενός αντικειμένου μπορεί να σχεδιαστεί απευθείας χρησιμοποιώντας ένα 
ορθογώνιο παραλληλεπίπεδο). 

• Είτε σε συνδυασμό με κάποιες γεωμετρικές ενέργειες που ονομάζονται Boolean 
operations, οι οποίες λόγω της σημασίας τους περιγράφονται στην επόμενη ενότητα. 

2.15 Boolean operations 

Οι Boolean operations είναι πρακτικά απλές ενέργειες τροποποίησης στερεών 
σωμάτων με βάση τη γεωμετρία Bool. Οι ενέργειες αυτές προσφέρουν τη δυνατότητα 
δημιουργίας πολύπλοκων στερεών αντικειμένων ως αποτέλεσμα τρόπων συνδυασμού 
δύο ή περισσότερων απλούστερων στερεών. Οι συνδυασμοί αυτοί είναι (σχήμα 8): 

1. Ένωση (union): ενώνει δύο στερεά σε ένα μόνο αντικείμενο. 

2. Αφαίρεση (subtract): αφαιρεί τον όγκο ενός στερεού από ένα άλλο. 

3. Τομή (intersection): βρίσκει τον κοινό όγκο μεταξύ δύο στερεών και τον διατηρεί 
σβήνοντας τα στερεά. 

Ο χρήστης έχει πρόσβαση στις Boolean operations πληκτρολογώντας Union (ή uni), 
Subtract (ή su) και Intersection (ή in) αντίστοιχα για κάθε μια. Επίσης, από το μενού 
Modify → Solids Editing ή από τη γραμμή εργαλείων Solids Editing (εμφανίζεται 
στην περιοχή σχεδίασης κάνοντας δεξί κλικ με το ποντίκι στην κύρια γραμμή 
εργαλείων και επιλέγοντας Solids Editing από το παράθυρο που εμφανίζεται). 

Μερικές συμβουλές/παρατηρήσεις που αφορούν τις Boolean operations: 
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• Αν και οι Boolean operations λειτουργούν και σε στερεά των οποίων οι όγκοι δεν 
τέμνονται συνίσταται να αποφεύγεται η χρήση τους σε τέτοιες περιπτώσεις.  

• Όσον αφορά την αφαίρεση (subtract), η σειρά επιλογής των στερεών έχει σημασία. 
Πρώτα επιλέγεται το στερεό από το οποίο θα γίνει η αφαίρεση και μετά το στερεό το 
οποίο θα αφαιρεθεί. 

• Η δημιουργία οπών (ιδιαίτερα για τις περιπτώσεις μηχανολογικών τεμαχίων) 
επιτυγχάνεται σχεδόν πάντα με την αφαίρεση ενός κυλίνδρου από ένα ορθογώνιο 
παραλληλεπίπεδο. 

• Η δημιουργία ποκετών ορθογωνικής διατομής (αρκετά συχνό χαρακτηριστικό 
μηχανολογικών τεμαχίων) επιτυγχάνεται με την αφαίρεση ενός ορθογωνίου 
παραλληλεπιπέδου από ένα άλλο. 

• Ποκέτες με διαφορετική διατομή ή που αλλάζουν κλίση συνίσταται να σχεδιάζονται 
με αφαίρεση στερεού, που έχει προκύψει από extrude της διατομής της ποκέτας κατά 
μήκος τροχιάς, από ορθογώνιο παραλληλεπίπεδο. 

• Από την τομή (instersection) στερεών αντικειμένων δημιουργούνται, κατά 
τεκμήριο, οι πιο πολύπλοκες γεωμετρίες και για αυτό το λόγο πρέπει να δίνεται 
μεγάλη προσοχή όταν χρησιμοποιείται. Συνίσταται να γίνεται ένας γρήγορος οπτικός 
έλεγχος του αποτελέσματος με την εντολή 3DORBIT. 

2.16 Δημιουργία τομών στερεών με τις εντολές SECTION και SLICE 

Οι εντολές SECTION (Section ή sec ή από το μενού Draw → Solids → Section) και 
SLICE (Slice ή sl ή από το μενού Draw → Solids → Slice) έχουν τον ίδιο σκοπό που 
είναι η δυνατότητα δημιουργίας τομών στερεών αντικειμένων χρησιμοποιώντας 
επίπεδα που ορίζονται από το χρήστη. Ο τρόπος ορισμού του επιπέδου τομής είναι 
μέσω των συντεταγμένων τριών σημείων του. 

Η διαφορά τους έγκειται στο αποτέλεσμα της κάθε εντολής: 

• Η εντολή Section δημιουργεί ένα νέο αντικείμενο που είναι η κοινή περιοχή μεταξύ 
του στερεού και του επιπέδου. Το AutoCAD τοποθετεί την περιοχή αυτή στο τρέχον 
επίπεδο σχεδίασης. 

• Η εντολή Slice τέμνει το στερεό κατά τη διεύθυνση του επιπέδου χωρίζοντας έτσι 
το στερεό σε δύο νέα διακριτά στερεά μοντέλα.  

Στο σχήμα 9 διακρίνονται (από αριστερά προς τα δεξιά) το αρχικό στερεό 
αντικείμενο και τα αποτελέσματα των εντολών Slice και Section. 

 Υπενθυμίζεται ότι κατά την εκκίνηση του AutoCAD το σύστημα συντεταγμένων που 
υπάρχει είναι το WCS με το αντίστοιχο εικονίδιο να δείχνει τις θετικές κατευθύνσεις 
των αξόνων X, Y. Το WCS είναι σταθερό και δεν μπορεί να μεταβληθεί από το 
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χρήστη. Έτσι, χρησιμοποιείται και ένα δεύτερο σύστημα συντεταγμένων που 
ονομάζεται UCS (User Coordinate System), το οποίο μπορεί να τροποποιήσει ο 
χρήστης με όποιο τρόπο θέλει (μετακίνηση του σημείου αρχής του συστήματος 
συντεταγμένων ή περιστροφή του συστήματος συντεταγμένων με οποιαδήποτε γωνία 
και γύρω από οποιοδήποτε άξονα ή και τα δύο ταυτόχρονα). 

Ο ορισμός του UCS γίνεται χρησιμοποιώντας την εντολή UCS ή από το μενού Tools 
→ New UCS. Οι επιλογές με τις οποίες μπορεί να οριστεί το UCS δίνονται στον 
πίνακα 14. 

Όνομα Επιλογής 
 

Αποτέλεσμα 
 

Origin 
 

Μετακινεί την αρχή του τρέχοντος συστήματος 
συντεταγμένων χωρίς να μεταβάλλει τον προσανατολισμό 
των αξόνων. Δε μεταβάλλει το επίπεδο σχεδίασης αφού 
επιλέγεται μόνο ένα σημείο. 

ZAxis 
 

Ο χρήστης πρέπει να επιλέξει την αρχή του νέου UCS και 
στη συνέχεια να ορίσει ένα σημείο προς τη θετική 
κατεύθυνση του άξονα Z. Οι άξονες X, Y 
προσανατολίζονται έτσι ώστε να σχηματιστεί δεξιόστροφο 
τρισορθογώνιο σύστημα. 

3point 
 

Ο χρήστης πρέπει να επιλέξει την αρχή του νέου UCS και 
στη συνέχεια να ορίσει από ένα σημείο προς τη θετική 
κατεύθυνση των αξόνων X και Y αντίστοιχα. Ο άξονας Z 
προσανατολίζεται έτσι ώστε να σχηματιστεί δεξιόστροφο 
τρισορθογώνιο σύστημα. 

OBject 
 

Ορίζει το νέο UCS έτσι ώστε η θετική κατεύθυνση του 
άξονα Z να συμπίπτει με τη φορά ανύψωσης ενός 
τρισδιάστατου αντικειμένου. Τα ακόλουθα αντικείμενα ΔΕΝ 
μπορούν να χρησιμοποιηθούν με την επιλογή αυτή: στερεά, 
τρισδιάστατες πολυγραμμές, splines, τρισδιάστατα 
πλέγματα, περιοχές, ελλείψεις, viewports, mtext, rays. 

View 
 

Περιστρέφει το τρέχον σύστημα συντεταγμένων έτσι ώστε 
το επίπεδο XY να είναι παράλληλο με την οθόνη. Η αρχή 
του συστήματος συντεταγμένων μένει σταθερή. 

X / Y / Z 
 

Περιστρέφει το τρέχον σύστημα συντεταγμένων γύρω από 
τον επιλεγμένο άξονα ανάλογα με τη γωνία που εισάγει ο 
χρήστης. 

 

Πίνακας 14. Τρόποι ορισμού UCS. 
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Ορισμός νέου UCS 

• Βήμα 1ο: Η αρχική κατάσταση όπου φαίνεται το WCS έχοντας επιλέξει ισομετρική 
οπτική γωνία του σχεδίου. Ας δοθεί προσοχή στο σταυρόνημα και στο εικονίδιο του 
συστήματος συντεταγμένων που ορίζουν το επίπεδο σχεδίασης. 

• Βήμα 2ο: Η εντολή UCS εκτελείται, ενεργοποιούνται πρώτα η επιλογή New και στη 
συνέχεια η επιλογή 3point. Το AutoCAD περιμένει την επιλογή της νέας αρχής του 
UCS. 

• Βήμα 3ο: Το AutoCAD περιμένει την επιλογή ενός σημείου που βρίσκεται στη 
θετική κατεύθυνση του άξονα X του νέου UCS.  

• Βήμα 4ο: Το AutoCAD περιμένει την επιλογή ενός σημείου που βρίσκεται στη 
θετική κατεύθυνση του άξονα Y του νέου UCS. 

• Βήμα 5ο: Το νέο UCS έχει οριστεί. Ας δοθεί προσοχή στο σταυρόνημα και στο 
εικονίδιο του συστήματος συντεταγμένων που ορίζουν το νέο επίπεδο σχεδίασης. 

Οποιοδήποτε UCS μπορεί να αποθηκευτεί με ένα χαρακτηριστικό όνομα καλώντας 
την εντολή UCS και ενεργοποιώντας την επιλογή Save, έτσι ώστε να διευκολυνθεί η 
μετάβαση μεταξύ των διαφορετικών συστημάτων συντεταγμένων που θα χρειαστεί 
να οριστούν από το χρήστη έως την ολοκλήρωση του σχεδίου. Όλα τα UCSs που 
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έχουν αποθηκευτεί με κάποιο όνομα εμφανίζονται πληκτρολογώντας UCSMAN στην 
περιοχή εντολών ή ακολουθώντας το μενού Tools → Named UCS. 

2.17 Τρισδιάστατες όψεις 

2.17.1 Αλλαγή όψης 

Η προεπιλεγμένη όψη του AutoCAD είναι κοιτώντας προς τα κάτω στο επίπεδο XY, 
ονομάζεται Top ή Plan View και ισοδυναμεί με την κάτοψη. Αν ο χρήστης μπορούσε 
να κοιτάξει ένα τρισδιάστατο αντικείμενο μόνο κοιτώντας το από αυτήν την όψη θα 
ήταν αδύνατο να εντοπίσει διαφορές, όπως για παράδειγμα σημεία που βρίσκονται 
στις ίδιες συντεταγμένες X, Y και σε διαφορετικό Z. Για να διευκολυνθεί η εποπτεία 
των τρισδιάστατων αντικειμένων, υπάρχει η δυνατότητα αλλαγής όψεων, ακριβώς σα 
να μπορούσε ο χρήστης να μετακινηθεί γύρω από τα αντικείμενα, με δύο τρόπους: 

1. Με την εντολή VIEW (View ή V ή από το μενού View → Named Views). 
Εμφανίζεται ένα παράθυρο διαλόγου (σχήμα 11) που προσφέρει τη δυνατότητα 
ορισμού της τρέχουσας όψης μέσω τυποποιημένων όψεων (ορθογραφικών ή 
ισομετρικών). Επίσης, από το παράθυρο αυτό ο χρήστης μπορεί να αποθηκεύσει 
οποιαδήποτε όψη με όνομα δικής του επιλογής, έτσι ώστε να μπορεί να την 
επαναφέρει αργότερα.  

2. Χρησιμοποιώντας την εντολή 3DORBIT (3dorbit ή 3do ή από το μενού View � 
3D Orbit). Με την εντολή αυτή ο χρήστης μπορεί να περιστρέψει την οπτική γωνία 
σε πραγματικό χρόνο χρησιμοποιώντας το ποντίκι, μέχρις ότου βρει την όψη που 
θέλει (σχήμα 12). Τοποθετώντας το ποντίκι εξωτερικά του μεγάλου κύκλου που 
εμφανίζεται και κρατώντας πατημένο το αριστερό κουμπί του, η οπτική γωνία 
περιστρέφεται γύρω από τον άξονα Z, καθώς το ποντίκι μετακινείται.  
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Τοποθετώντας το ποντίκι στους δύο μικρότερους κύκλους που βρίσκονται πάνω και 
κάτω και κρατώντας πατημένο το αριστερό κουμπί του, η οπτική γωνία 
περιστρέφεται γύρω από τον άξονα Y, καθώς το ποντίκι μετακινείται. Τέλος, 
Τοποθετώντας το ποντίκι στους δύο μικρότερους κύκλους που βρίσκονται δεξιά και 
αριστερά και κρατώντας πατημένο το αριστερό κουμπί του, η οπτική γωνία 
περιστρέφεται γύρω από τον άξονα X, καθώς το ποντίκι μετακινείται. 
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Κατά την εκτέλεση της εντολής αυτής, ο χρήστης μπορεί επίσης να χρησιμοποιήσει 
τις εντολές ZOOM και PAN, κάτι που διευκολύνει πάρα πολύ στην εύρεση της 
ιδανικής οπτικής γωνίας. Χρησιμοποιείται είτε για μια γρήγορη προεπισκόπιση του 
τρισδιάστατου χαρακτήρα ενός αντικειμένου που μόλις σχεδιάστηκε είτε για τον 
ακριβή ορισμό μιας μη τυποποιημένης οπτικής γωνίας σε ένα σχέδιο. Η νέα όψη 
μπορεί να αποθηκευτεί με την εντολή VIEW. 

2.17.2 Αλλαγή αριθμού όψεων 

Το AutoCAD δίνει τη δυνατότητα ταυτόχρονης προβολής περισσοτέρων των μια 
όψεων του ίδιου σχεδίου δημιουργώντας παράθυρα όψεων (viewports), 
χρησιμοποιώντας την εντολή VIEWPORTS (Viewports ή Vports ή από το μενού 
View → Viewports → New Viewports. Πρακτικά, η περιοχή σχεδίασης χωρίζεται σε 
μικρότερες που απεικονίζουν το σχέδιο από διαφορετικές οπτικές γωνίες (σχήμα 13).  

 

 

Η διάταξη των παραθύρων αυτών εξαρτάται από το πλήθος τους, το οποίο πρακτικά 
περιορίζεται από τη διάσταση και ανάλυση της οθόνης του Η/Υ.. Όταν αρχικά ο 
χρήστης τα δημιουργεί, επιλέγει και ποια από τις τυποποιημένες οπτικές γωνίες 
αντιστοιχεί στο κάθε παράθυρο όψης, αν και έχει τη δυνατότητα να αλλάξει τις 
οπτικές γωνίες κατά τη διάρκεια της σχεδίασης. Επιπλέον, ο χρήστης μπορεί 
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συνδυάζοντας τις τυποποιημένες διατάξεις των παραθύρων όψης να φτιάξει νέες και 
να τις σώσει με όποιο όνομα επιθυμεί. 

 Από όλα τα παράθυρα όψης μόνο ένα μπορεί να είναι ενεργό κάθε φορά και το ποιο 
είναι αυτό σημειώνεται με ένα παχύτερο περιθώριο γύρω του. Για να οριστεί ένα 
άλλο παράθυρο όψης ως ενεργό, αρκεί να γίνει μια φορά αριστερό κλικ με το ποντίκι 
μέσα του. Σημειώνεται ότι οι οποιεσδήποτε τροποποιήσεις του σχεδίου γίνονται σε 
ένα παράθυρο όψης εφαρμόζονται απευθείας και στα υπόλοιπα. 

2.18 Εκτυπώνοντας από το AutoCAD 

Όπως έχει προαναφερθεί, όλα τα αντικείμενα σχεδιάζονται στο AutoCAD στο φυσικό 
τους μέγεθος. Όταν όμως πρέπει να εκτυπωθούν είναι αναγκαίο να προσαρμοστούν 
σε μια συγκεκριμένη κλίμακα. Για το σκοπό αυτό, το AutoCAD χρησιμοποιεί δύο 
διαφορετικούς χώρους, το χώρο μοντέλου (model space) και το χώρο χαρτιού (paper 
space ή layout). Ο χώρος μοντέλου είναι ο χώρος στον οποίο δημιουργείται το σχέδιο, 
ενώ ο χώρος χαρτιού είναι ο χώρος από τον οποίο το σχέδιο εκτυπώνεται. 

Το πλεονέκτημα που προσφέρει αυτός ο διαχωρισμός είναι ότι από το χώρο μοντέλου 
μπορούν να δημιουργηθούν πολλοί χώροι χαρτιού με διαφορετικές απόψεις του 
σχεδίου, χωρίς να χρειαστεί να μεταβληθούν καθόλου τα αντικείμενα (μετακίνηση, 
μεγέθυνση κλπ). Επιπλέον, οποιαδήποτε αλλαγή γίνει στο χώρο μοντέλου 
μεταφέρεται αυτόματα και στο χώρο χαρτιού, αυξάνοντας έτσι την ευελιξία. Η 
μετακίνηση από τον ένα χώρο στον άλλο επιτυγχάνεται από τις καρτέλες που 
βρίσκονται στο κατώτερο μέρος της περιοχής σχεδίασης. Από το χώρο χαρτιού 
μπορούν να δημιουργηθούν παράθυρα όψεων (viewports) που “βλέπουν” στο χώρο 
μοντέλου χρησιμοποιώντας την εντολή MVIEW (τα παράθυρα αυτά είναι 
διαφορετικά από τα παράθυρα όψεων που περιγράφηκαν παραπάνω). Μόλις 
δημιουργηθεί ένα viewport, κάνοντας διπλό κλικ με το αριστερό πλήκτρο του 
ποντικιού στο εσωτερικό του, αυτό ενεργοποιείται έτσι ώστε να οριστεί η οπτική 
γωνία του σχεδίου που είναι επιθυμητή από το χρήστη χρησιμοποιώντας τις εντολές 
απεικόνισης (ZOOM, PAN, VIEW κλπ). Η ίδια η viewport μπορεί να μετακινηθεί και 
να τοποθετηθεί σε οποιοδήποτε σημείο του χώρου χαρτιού χρησιμοποιώντας τις 
λαβές της, όπως και σε οποιοδήποτε άλλο αντικείμενο του AutoCAD. Ο χρήστης 
μπορεί να δημιουργήσει όσες viewports επιθυμεί στο χώρο χαρτιού, καλώντας κάθε 
φορά την εντολή MVIEW. Η έξοδος από τη viewport γίνεται κάνοντας διπλό κλικ με 
το αριστερό πλήκτρο του ποντικιού έξω από αυτή. Αφού δημιουργηθεί μια viewport 
και οριστεί η άποψή της, η τελευταία ενέργεια που απομένει είναι η προσαρμογή της 
στην επιθυμητή κλίμακα. Αυτή επιτυγχάνεται με τη χρήση της εντολής ZOOM. 
Αναλυτικά η διαδικασία που ακολουθείται είναι η εξής: 
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1. Η viewport ενεργοποιείται. 

2. Εκτελείται η εντολή ZOOM. 

3. Στην προτροπή, εισάγεται η επιθυμητή κλίμακα με τη μορφή _/_XP (π.χ. 1/2XP 
σημαίνει ότι το σχέδιο θα εκτυπωθεί σε κλίμακα 1:2 ή στο μισό των πραγματικών του 
διαστάσεων και 3/1XP σημαίνει ότι το σχέδιο θα εκτυπωθεί σε κλίμακα 3:1 ή 3 φορές 
μεγαλύτερο από την πραγματικότητα).  

4. Η viewport απενεργοποιείται. 

Το σχέδιο είναι έτοιμο για εκτύπωση επιλέγοντας την εντολή PLOT από το μενού 
File → Plot. Συνίσταται ο χρήστης να ελέγχει ΠΑΝΤΑ το τι θα εκτυπωθεί 
χρησιμοποιώντας το κουμπί Full Preview που βρίσκεται στο κάτω αριστερό άκρο του 
παραθύρου διαλόγου που εμφανίζεται και στη συνέχεια να προχωρεί στην εκτύπωση. 

Επίσης, σημειώνεται ότι αν δεν έχουν οριστεί προηγουμένως κατά τη δημιουργία του 
σχεδίου, τότε όταν επιλεχθεί για πρώτη φορά η καρτέλα του χώρου χαρτιού τότε το 
AutoCAD θα εμφανίσει ένα παράθυρο διαλόγου στο οποίο ο χρήστης πρέπει να 
ορίσει τον εκτυπωτή και το μέγεθος του χαρτιού που θα χρησιμοποιηθούν. 
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ΚΕΦΑΛΑΙΟ 3  

ΕΝΑΡΞΗ 
ΜΑΘΗΜΑΤΩΝ 

 
3.1 Εισαγωγή - Πρακτική εφαρμογή στο εργαστήριο 

Για την καλύτερη και πιο αποτελεσματική κατανόηση της θεωρητικής εκπαίδευσης 
που αναλύθηκε στο κεφάλαιο 2 εκτενώς, οι φοιτητές χρειάζεται να παρακολουθήσουν 
και κυρίως να συμμετάσχουν στις εργαστηριακές ασκήσεις του μαθήματος για να 
αποκτήσουν μία, όσο είναι δυανατόν, ολοκληρωμένη γνώση περί σχεδίασης στο 
μηχανολογικό και ηλεκτρολογικό τομέα. Στο κεφάλαιο της εργασίας, που ακολουθεί, 
γίνεται μία εξομοίωση των φοιτητών, σε πρακτικό επίπεδο, σχεδιάζοντας αντικείμενα 
που αποτελούν κυρίως, μηχανολογικό εξοπλισμό.  

3.2 Εργαστηριακές Ασκήσεις 

Στην παρούσα εργασία, σαν πρακτική εξάσκηση των φοιτητών στο σχεδιασμό, 
πραγματοποιείται μία σειρά μαθημάτων με ασκήσεις στο εργαστήριο, όπου οι 
φοιτητές, με τη βοήθεια του αρμόδιου εκπαιδευτικού προσωπικού, καλούνται να 
σχεδιάσουν με τη βοήθεια του ηλεκτρονικού υπολογιστή.   
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3.2.1 Εργαστηριακή Άσκηση 1 – Σχεδίαση διαφόρων τύπων ελασμάτων 
πυρήνων μετασχηματιστών 

Οι διαστάσεις,των διαφόρων τύπων ελασμάτων πυρήνων μετασχηματιστών, δίνονται 
σε mm, το δε πάχος αναγράφεται επί του ελάσματος, π.χ. 0.3. Κατά την αναγραφή 
των διαστάσεων λαμβάνεται υπ’όψιν ο άξονας συμμετρίας του εξαρτήματος και ως 
βάση η μία των πλευρών του. 

Για το σχήμα 1 (Εικόνα 3.1), χρησιμοποιήσαμε την εντολή Line στο συγκεκριμένο 
σχέδιο . Η επιλογή Line γίνεται από το Menu → Draw (icon),το πρόγραμμα θα μας 
ζητήσει να ορίσουμε την αρχή της γραμμής. Ορίζουμε με το ποντίκι τη συντεταγμένη 
προσεγγιστικά στο σημείο που επιθυμούμε επί της περιοχής σχεδίασης. Η 
προσεγγιστική αυτή μέθοδος γίνεται μιας και η ακρίβεια εξαρτάται από πολλούς 
παράγοντες όπως σταθερότητα ποντικιού, μέγεθος οθόνης, ανάλυση οθόνης, κ.λπ. 

 

 

Εικόνα 3.1 – Σχεδίαση διαφόρων τύπων ελασμάτων πυρήνων 
μετασχηματιστώνσχήμα σχήμα 1 

Η δεύτερη εντολή  Ortho που χρησιμοποιήθηκε στα συγκεκριμένα σχήματα μας 
προσφέρει τη δυνατότητα να σχεδιάζουμε αποκλειστικά στην οριζόντια η στη κάθετη 
διεύθυνση (παράλληλα προς τον άξονα των X και Y) επί της ουσίας ανακαλεί το 
σταυρόνημα του ποντικιού να κινείται μόνο σε αυτές τις δυο κατεύθυνσης και μόνο 
εκεί να μπορεί να ορίσει σημεία, όπως στα σχήματα που παρουσιάζουμε αν θέλουμε 
να σχεδιάσουμε ένα ευθύγραμμο τμήμα θα δώσουμε το πρώτο σημείο του και το 
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επόμενο σημείο θα μπορεί να δοθεί μόνο στον οριζόντιο ή κατακόρυφο άξονα 
έχοντας ως βάση το πρώτο σημείο. 

Για το πρώτο σχήμα του Σχεδίου 1 ορίσαμε ως πρώτο σημείο ένα τυχαίο στο επίπεδο 
XY. Δόθηκε το πρώτο σημείο. Με το παραπάνω τρόπο όπως περιγράφηκε, ορίσαμε 
την αρχή της γραμμής, αυτό έγινε καθ υπόδειξη του προγράμματος το οποίο μας 
ζήτησε να του ορίσουμε το πρώτο σημείο του ευθύγραμμου τμήματος. 

Για το δεύτερο σημείο του ευθύγραμμου τμήματος με επιλεγμένη την εντολή Ortho 
κινηθήκαμε ως προς το θετικό άξονα των X και στη γραμμή εντολών (Command 
Line) ορίσαμε το δεύτερο σημείο σε απόσταση 20 από το πρώτο. Σχεδιάσαμε το 
ευθύγραμμο τμήμα διάστασης 20 όπως φαίνεται στο Σχήμα 1 του Σχεδίου 1. 

Στη συνέχεια το πρόγραμμα μας ζητάει να οριστεί το επόμενο σημείο και αυτό 
ορίζεται κινούμενοι ως προς τον αρνητικό άξονα των Y (δηλαδή το σταυρόνημα 
κινήθηκε προς τα κάτω) σε απόσταση 80. Το τρίτο ευθύγραμμο τμήμα χωρίς να 
διακόψουμε την εντολή συνεχίζουμε κινούμενοι προς τον αρνητικό των Χ (δηλαδή το 
σταυρόνημα του ποντικιού αριστερά σε απόσταση 20). Το τελικό ευθύγραμμο τμήμα 
διάστασης (80) δημιουργήθηκε με την εντολή Close (C) στη γραμμή εντολών 

Για τη διευκόλυνση του χρήστη , το Autocad παρέχει τη δυνατότητα έλξης Osnap η 
οποία ενεργοποιείται κάνοντας αριστερό κλικ στο αντίστοιχο εικονίδιο. Αυτή η 
εντολή μας βοηθάει όταν έχουμε ένα project με πολλά σχήματα να κατασκευάζουμε 
σχήματα εξαρτώντας τα ως υφιστάμενα. Η έλξη επίσης ισχύει για συγκεκριμένα 
χαρακτηριστικά σημεία όπως το άκρο ενός ευθυγράμμου τμήματος, το μέσο του, το 
σημείο τομής δυο γραμμών ή το κέντρο ενός κύκλου κ.α. Κάνοντας δεξί κλικ στο 
εικονίδιο Osnap επιλέγουμε την εντολή Settings και ενεργοποιούμε το παράθυρο 
Drafting Settings , μέσω του παραθύρου αυτού μας δίνεται η δυνατότητα να 
επιλέξουμε ποια χαρακτηριστικά σημεία θέλουμε να ενεργοποιήσουμε και τα οποία 
θα λαμβάνει υπόψιν η εντολή έλξης. 

Μόλις επιλεχθούν τα επιθυμητά σημεία έλξης πατάμε Ok. Με την εντολή Osnap όταν 
το σταυρόνημα του ποντικιού πλησιάζει ένα σχεδιαστικό αντικείμενο, το πρόγραμμα 
αναγνωρίζει τις γραμμές και τα τόξα από τα οποία αποτελείται και μόλις περάσει 
δίπλα από ένα χαρακτηριστικό σημείο δημιουργεί ένα σχήμα επί του σημείου. 

Στο συγκεκριμένο σχήμα κινούμενοι επάνω στη γραμμή διάστασης 20 η εντολή 
Osnap αναγνωρίζει το μέσο της παράλληλης γραμμής ,η οποία βρίσκεται σε 
απόσταση 80 από την αρχική μας. Με τον τρόπο αυτό ολοκληρώνουμε την ένωση 
των δυο μέσων με ένα ευθύγραμμο τμήμα διάστασης 80. 

Για να επιτύχουμε τον επιθυμητό τύπο γραμμής επιλέγουμε την εντολή Linetype από 
το Main Toolbox, επιλέγοντας Linetype AKAD_ISO 04W100. Για τη δημιουργία των 
αριθμών 0.5 και 1 όπως φαίνονται στο σχήμα επιλέχθηκε η εντολή Multiline Text από 
το Main Toolbox και ορίζοντας τις κατάλληλες διαστάσεις των γραμμάτων. 
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Το σχήμα κλείνει αποτυπώνοντας τις διαστάσεις των ευθύγραμμων τμημάτων. Στο 
Menu Dimension επιλέγουμε την εντολή Linear  και με πολύ απλές κινήσεις απλά 
επιλέγοντας το αντίστοιχο ευθύγραμμο τμήμα που έχουμε σχεδιάσει αποτυπώνουμε 
την αντίστοιχη διάσταση επιλέγοντας το κατάλληλο στυλ. 

Στο σχήμα 4 η μόνη διαφορά  στο Multiline Text είναι ότι αναβάλλουμε την επιλογή 
Ortho και ορίζουμε το ευθύγραμμο τμήμα σε γωνία 45ο . Τα σχήματα 2 και 3 
σχεδιάζονται όπως το σχήμα 1. Σαν εργασία για τους φοιτητές προτείνεται η 
σχεδίαση των σχημάτων 2 (Εικόνα 3.2),3 (Εικόνα 3.3) και 4 (Εικόνα 3.4), σύμφωνα 
με τα παραπάνω. Η διάρκεια του μαθήματος είναι 2 ώρες. 

 

Εικόνα 3.2 – Σχεδίαση διαφόρων τύπων ελασμάτων πυρήνων 
μετασχηματιστώνσχήμα σχήμα 2 
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Εικόνα 3.3 – Σχεδίαση διαφόρων τύπων ελασμάτων πυρήνων 
μετασχηματιστώνσχήμα σχήμα 3 

 

Εικόνα 3.4 – Σχεδίαση διαφόρων τύπων ελασμάτων πυρήνων 
μετασχηματιστώνσχήμα σχήμα 4 
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3.2.2 Εργαστηριακή Άσκηση 2 – Σχεδίαση ελασμάτων διαφόρων παχών 

Επίσης χρήσιμη εντολή είναι η Circle με την οποία μπορούμε να κατασκευάσουμε 
κύκλους πατώντας το αντίστοιχο εικονίδιο στο Draw Toolbox , το πρόγραμμα μας 
ζητάει να ορίσουμε τις συντεταγμένες του κέντρου. Για τη κατασκευή των κύκλων 
στο Σχήμα 5 (Εικόνα 3.5) στο Σχέδιο 2 ορίσαμε το κέντρο με το ποντίκι και στην 
επιλογή Command Line διατηρήσαμε την default επιλογή Radius (ακτίνα) και 
δώσαμε τη τιμή 25 για το μεγάλο κύκλο και πατήσαμε Enter. 

Σε απόσταση 12.5 από το κέντρο του κύκλου δημιουργήσαμε το κέντρο του 
μικρότερου κύκλου διαμέτρου 5 μια από τη  δεξιά και μια φορά από την αριστερή , 
στη συνέχεια κατασκευάσαμε με τον τρόπο που περιγράφηκε στο προηγούμενο 
μάθημα το ορθογώνιο παραλληλόγραμμο στο κέντρο του μεγάλου κύκλου πλευρών 
12 και 8. 

Στη συνέχεια ενώσαμε τα κέντρα των δυο μικρότερων κύκλων επιλέγοντας την 
εντολή Line και Ortho, όπως επίσης τραβήξαμε γραμμή δείχνοντας τη διάμετρο όπου 
διέρχεται από το κέντρο του μεγάλου κύκλου και του παραλληλογράμμου όπως 
φαίνεται στο σχήμα. 

Για το τέλος ορίσαμε τις διαστάσεις (εντολή Linear) και με την εντολή Aligned τα 
τμήματα υπό γωνία ,όπως επίσης Multiline Text δώσαμε τον αριθμό του σχεδίου (5) 
και τον αριθμό 3. Για να επιτύχουμε τον επιθυμητό τύπο γραμμής επιλέγουμε την 
εντολή Linetype από το  Main Toolbox, επιλέγοντας Linetype AKAD_ISO04W100.     

 

Εικόνα 3.5 – Εξάρτημα από έλασμα, σχήμα 5  
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Για το σχήμα 6 (Εικόνα 3.6) του σχεδίου 2 φτιάξαμε δυο ομόκεντρους κύκλους 
διαμέτρου 32 και 13. Δημιουργήσαμε το ευθύγραμμο τμήμα (12) σε απόσταση 28 
από το κέντρο του κύκλου και τις δυο κάθετες πλευρές του. Στη συνέχεια επιλέξαμε 
την εντολή Fillet, με την οποία ορίσαμε ένα τόξο ακτίνας 10 αφού επιλέξαμε την 
εντολή Radius στο Command Line. Δίνουμε καμπύλη στο τμήμα με το οποίο 
ενώνουμε δυο ξεχωριστά τμήματα, στον παρών σχήμα ο κύκλος και από δυο φορές 
σε κάθε κάθετη πλευρά. Στη συνέχεια με την εντολή Trim  και επιλέγοντας τα 
τμήματα των οποίων τα τελειώματα θέλουμε να περικόψουμε, δίνουμε την τελική 
μορφή του σχήματος. Για το τελείωμα φέρνουμε τις κάθετες γραμμές που διέρχονται 
από το κέντρο των κύκλων, δίνουμε τις διαστάσεις και αριθμούμε το σχήμα.  

 

Εικόνα 3.6 – Εξάρτημα από έλασμα, σχήμα 6  

Σαν εργασία προς τους φοιτητές προτείνεται η σχεδίαση του σχήματος 7 (Εικόνα 3.7) 
στο σχέδιο 2, σύμφωνα με τα παραπάνω. Η διάρκεια του μαθήματος είναι 2 ώρες. 
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Εικόνα 3.7 – Εξάρτημα από έλασμα, σχήμα 7  

3.2.3 Εργαστηριακή Άσκηση 3 – Σχεδίαση διαφόρων ελασμάτων με διαφορετικά 
πάχη 

Στο σχήμα 1 (Εικόνα 3.8) του ΣΧΕΔΙΟΥ 3 δημιουργήσαμε τρείς ομόκεντρους 
κύκλους ακτινών 25,30 και 40. Στο μεσαίο κύκλο μετρήσαμε απόσταση 30΄φέραμε 
τα ευθύγραμμα τμήματα με την εντολή Line και Ortho και ενώσαμε τους δυο 
κύκλους , με την εντολή Trim περικόψαμε τα τελειώματα των τμημάτων που δεν 
χρειαζόμασταν. Φέραμε τα δυο ευθύγραμμα τμήματα που διέρχονται από το κέντρο 
του κύκλου. Για το τέλος δώσαμε τις διαστάσεις με τις εντολές Linear, Radius και 
Diameter και δώσαμε τον αριθμό του σχήματος με το Multiline Text. 

 

Εικόνα 3.8 – Εξάρτημα από έλασματα διαφορετικών παχών, σχήμα 1  
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Στο σχήμα 4 (Εικόνα 3.9) κάναμε το κύκλο διάμετρο 70, από τη κορυφή του κύκλου 
φέραμε ευθύγραμμο τμήμα απόστασης 40, δημιουργήσαμε κύκλο διαμέτρου 100, 
φέραμε τη κορυφή του κύκλου να συναντήσει το End Point του ευθυγράμμου 
τμήματος 40, περικόψαμε τα τελειώματα των τμημάτων που δεν χρειαζόμαστε. 

Στη συνέχεια δημιουργήσαμε το τετράγωνο πλευράς 10 και φέρνουμε το κέντρο σε 
απόσταση 15 από την κορυφή του κύκλου διαμέτρου 70. Για τη τελική μορφή με τις 
εντολές Linear, Diameter, Jog Dimension και Multiline Text αποδίδουμε τις 
διαστάσεις και την αρίθμηση του σχήματος. Οι διακεκομμένες έχουν γίνει με 
Linetype AKAD_ISO04W100. 

 

Εικόνα 3.9 – Εξάρτημα από έλασματα διαφορετικών παχών, σχήμα 4  

Σαν εργασία προς τους φοιτητές προτείνεται η σχεδίαση του σχήματος 2 (Εικόνα 
3.10) και 3 (Εικόνα 3.11), σύμφωνα με τα παραπάνω.  Η διάρκεια του μαθήματος 
είναι 2 ώρες. 
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 Εικόνα 3.10 – Εξάρτημα από έλασματα διαφορετικών παχών, σχήμα 2  

 

 

 

Εικόνα 3.10 – Εξάρτημα από έλασματα διαφορετικών παχών, σχήμα 3  
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3.2.4 Εργαστηριακή Άσκηση 4 – Σχεδίαση εξαρτήματος σε πρόσοψη, πλάγια 
όψη και κάτοψη. 

Στα παρακάτω σχέδια (Εικόνα 3.11, α,β,γ ), οι αριθμοί που δίνονται, σημαίνουν οι 
γωνίες του εξαρτήματος. Εκεί που υπάρχουν δύο αριθμοί (εντός παρενθέσεως), οι 
γωνίες συμπίπτουν στο σχέδιο.  

Τα σχέδια, είναι εφικτό να πραγματοποιηθούν, με τις πληροφορίες των 
προηγουμένων εργαστηριακών ασκήσεων και αποτελούν ένα διαγώνισμα γνώσεων 
και ικανοτήτων για τους φοιτητές, με σκοπό την εξοικείωση τους με το αντικείμενο 
του σχεδιασμού.  

 

α.  

β. 

 

 

  γ. 

Εικόνα 3.11 – Πρόσοψη (α), πλάγια όψη (β) και κάτοψη (γ) εξαρτήματος  
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3.2.5 Εργαστηριακή Άσκηση 5 – Σχεδίαση δύο πυρήνων μετασχηματιστή σε 
πρόοψη, κάτοψη και πλάγια όψη. 

Στην εργαστηριακή άσκηση 5, οι φοιτητές καλούνται να σχεδιάσουν δύο πυρήνες 
μετασχηματιστή, σε πρόοψη, κάτοψη και πλάγια όψη (Εικόνα 3.12, α. και β.). 
Αποτελεί ένα συνδυασμό γνώσεων, από τις προηγούμενες ασκήσεις, βοηθώντας τους 
φοιτητές να κατανοήσουν καλύτερα, τις εντολές και το περιβάλλον, του σχεδιαστικού 
προγράμματος AutoCAD. Η διάρκεια του μαθήματος είναι 2 ώρες. 

 

α. 

 

 β. 

 Εικόνα 3.12 – Πρόοψη, πλάγια όψη και κάτοψη (α),(β), δύο πυρήνων 
μετασχηματιστή  
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3.2.6 Εργαστηριακή Άσκηση 6 – Σχεδίαση δύο εξαρτημάτων στήριξης 

Στην παρούσα εργαστηριακή άσκηση, πραγματοποιείται σχεδιασμός δύο 
εξαρτημάτων στήριξης (Εικόνα 3.13, (α) και (β)),  με έμφαση στις εντολές Line, 
Circle και Fillet. Η διάρκεια του μαθήματος είναι 2 ώρες. 

 

Εικόνα 3.13 – Δύο εξαρτήματα στήριξης  
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3.2.7 Εργαστηριακή Άσκηση 7 – Σχεδίαση εξαρτήματος συμμετρικού ως προς 
τον άξονα 

Στο Σχέδιο 7  (Εικόνα 3.14), σχεδιάζεται  εξάρτημα συμμετρικού ως προς τον άξονα, 
σε κάτοψη, πλάγια όψη και τομή. Το σύμβολο Ø στις διαστάσεις π.χ. 40 Ø σημαίνει 
κυκλική διατομή. Το  για τη βάση του σχήματος φτιάξαμε ευθύγραμμο τμήμα 30 που 
σημαίνει κυκλικά. Φέραμε ευθύγραμμο τμήμα  15 στο End Point  του 30, μετά 
συνεχίζοντας με την εντολή Line και Ortho  σχεδιάσαμε ευθύγραμμο τμήμα 
διάστασης 10, συνεχίσαμε προς τα πάνω ευθύγραμμο τμήμα 30. Στη συνέχεια από το 
ευθύγραμμο τμήμα 30 κάτω κάτω  από τη βάση από την αριστερή πλευρά φέραμε 
ευθύγραμμο τμήμα 90 κάθετα προς τα πάνω, στη συνέχεια φέραμε ευθύγραμμο 
τμήμα 10 προς τα δεξιά, ευθύγραμμο τμήμα 15 προς τα κάτω στη συνέχεια, και 
απόσταση 5 δεξιά , μετά βγάλαμε την επιλογή Ortho και με την εντολή Line ενώσαμε 
το κενό των δυο σημείων. Από το μέσο της πλευράς κορυφής φέραμε κάθετο τμήμα 
διάστασης 35 , μετά κινηθήκαμε προς τα δεξιά με ευθύγραμμο τμήμα 5 το οποίο 
κάναμε Stretch  προς τα αριστερά δίνοντας του πρόσθετο τμήμα 5 δημιουργώντας 
τελικά ένα ενιαίο τμήμα διάστασης 10. Στη συνέχεια από το ημιτελές τμήμα που 
δημιουργήσαμε απόστασης 10 κατασκευάσαμε ευθύγραμμο τμήμα 55 κάθετο 
τέμνοντας τη βάση μας.  

Στο σημείο αυτό επιλέχθηκε η εντολή Hatch η οποία αποτελεί μια από τις πιο 
χρήσιμες εντολές σε περιπτώσεις όπου θέλουμε να δημιουργήσουμε γεμίσματα 
συγκεκριμένων επιφανειών ούτως ώστε να ξεχωρίζουν από άλλες αντίστοιχες οι 
οποίες μπορούν να υποδουλώνουν την ύπαρξη διαφορετικού υλικού όπως πλακάκι , 
κεραμίδι σκυρόδεμα , κτλ. Το εικονίδιο Hatch βρίσκεται στο Toolbox . Ενεργοποιεί 
την εντολή Hatch και το αντίστοιχο παράθυρο εμφανίζεται. Για την ενεργοποίηση της 
εν λόγω εντολής πρέπει να υπάρχει τουλάχιστον ένας κλειστός χώρος ο οποίος να 
έχει συνεχόμενο σύνολο ( Boundary) . Στο παράθυρο που μας εμφανίζεται μας ζητάει 
τον τύπο του γεμίσματος τον οποίο παραθέτει ως δείγμα για να ξέρουμε τι επιλέξαμε, 
στο συγκεκριμένο σχήμα έχουμε επιλέξει ως Hatch Pattern INS31 σε Scale 1. Στη 
συνέχεια καλούμαστε να επιλέξουμε το κλειστό σύνορο μέσα στο οποίο θα γίνει η 
σκιαγράφηση , η σκιαγράφηση γίνεται με 2 επιλογές (Add : pick points και select 
object). Η πρώτη επιλογή που χρησιμοποιήθηκε είναι επιλογή ενός σημείου εντός του 
συνόρου, όπου το AutoCAD ανιχνεύει και βρίσκει το σύνορο από μόνο του ενώ η 
δεύτερη είναι επιλογή αντικειμένων (π.χ. ορθογώνιο) μέσα στο οποίο θέλουμε να 
γίνει εισαγωγή Hatch. 

Στη συνέχεια με την επιλογή Mirror  δημιουργήσαμε αντικείμενο μέσω της μεθόδου 
του αντικατοπτρισμού. Στο συγκεκριμένο σχήμα αφού το επιλέξαμε δώσαμε την 
εντολή Mirror  και αντικατοπτρίσαμε γύρω από το συγκεκριμένο άξονα που είχε 
αρχή το κάτω αριστερά μέρος του ευθύγραμμου τμήματος 30 . Έτσι  δημιουργήσαμε 
ολόκληρο το σχήμα , στη συνέχεια δώσαμε τις διαστάσεις όπου χρειάστηκε.    
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Εικόνα 3.14 – Εξάρτημα συμμετρικό ως προς τον άξονα  

Σαν εργασία πράδοσης, προτείνεται η σχεδίαση άλλων εξαρτημάτων συμμετρικών ως 
προς τον άξονα (Εικόνα 3.15, (α) και (β)). Η διάρκεια του μαθήματος είναι 2 ώρες.        

 

 α. β. 
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γ. 

Εικόνα 3.15 - Εξαρτήματα συμμετρικά ως προς τον άξονα (α), (β) και (γ) 

 

3.2.8 Εργαστηριακή Άσκηση 8 – Σχεδίαση εξαρτημάτων συνδεδεμένων μεταξύ 
των 

Στην εργαστηριακή άσκηση 8, οι φοιτητές συνδυάζουν τη γνώση των προηγουμένων 
ασκήσεων, εργαζόμενοι σε ένα συνδυασμό εντολών, για σχεδίαση εξαρτημάτων 
συνδεδεμένων μεταξύ των, σε πρόοψη και τομή (Εικόνα 3.16). Η διάρκεια του 
μαθήματος είναι 2 ώρες. 
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Εικόνα 3.16 – Σχεδίαση εξαρτημάτων συνδεδεμένων μεταξύ των 
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3.2.9 Εργαστηριακή Άσκηση 9 – Σχεδίαση συνδέσεως δύο ελασμάτων δια 
φυτευτών κοχλίων  

Η εργαστηριακή άσκηση 9, ασχολείται με τη σχεδίαση συνδέσεως δύο ελασμάτων 
δια φυτευτών κοχλίων (μπουζόνια), σε τομή (Εικόνα 3.18). Εδώ, οι μηχανικοί, 
χρησιμοποιούν κυρίως τις εντολές Fillet, Hatch, Line Weight και την εντολή Sketch. 
Η τελευταία, δίνεται εύκολα, αν πληκτρολογήσουμε τη λέξη Sketch, στην γραμμή 
εντολών (command window). Χρησιμοποείται για να σχεδιάσουμε τη δεξιά πλευρά 
του ελάσματος, δίνοντας την αίσθηση της ελεύθερης σχεδίασης με το χέρι. Η 
διάρκεια του μαθήματος είναι 2 ώρες. 

 
Εικόνα 3.18 - Σχεδίαση συνδέσεως δύο ελασμάτων δια φυτευτών κοχλίων σε 

τομή. 

3.2.10 Εργαστηριακή Άσκηση 10 – Σχεδίαση εξωτερικού κοχλίου μετά 
περικοχλίου 

Για να σχεδιαστεί ο εξαγωνικός κοχλίας μετά περικοχλία, σε πλάγιες όψεις και 
κάτοψη (Εικόνα 3.19), χρησιμοποιούνται κυρίως οι εντολές Line, Circle, Arc, Fillet 
και Text με τις απαραίτητες τροποποιήσεις στα Properties αυτών. Το Μ, π.χ. 20 Μ 
σημαίνει « μετρικό σπείρωμα ». Η διάρκεια του μαθήματος είναι 2 ώρες. 
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Εικόνα 3.19 - Σχεδίαση εξωτερικού κοχλίου μετά περικοχλίου 

3.2.11 Εργαστηριακή Άσκηση 11 – Σχεδίαση εξαρτημάτων, σε κάτοψη, πλάγια 
όψη, πρόοψη.  

Στην εργαστηριακή άσκηση 11, πραγματοποιείται σχεδιασμός εξαρτημάτων, σε 
κάτοψη, πλάγια όψη, πρόοψη (εικόνα 3.20, β.). Το σχήμα 1 (εικόνα 3.20, α.), 
σχεδιάστηκε σε τρισδιάστατη μορφή. Χρησιμοποιήθηκαν οι εντολές Extrude για να 
προσδώσει τη διάσταση του ύψους στο αντικείμενο και η Substract, που αφαιρεί τον 
όγκο ενός στερεού από ένα άλλο. Η διάρκεια του μαθήματος είναι 2 ώρες. 
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 → 
α. 

 

 

 

 

 

 

 

 

 

 

 

 

β. 

Εικόνα 3.20 -  α. Σχέδιο σε τρισδιάστατη μορφή (3D) 

β. Σχεδίαση εξαρτημάτων, σε κάτοψη, πλάγια όψη, πρόοψη 
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3.2.12 Εργαστηριακή Άσκηση 12 – Σχεδίαση εξαρτημάτων, σε κάτοψη, πλάγια 
όψη, πρόοψη 

Στην εργαστηριακή άσκηση 12, πραγματοποιείται σχεδιασμός εξαρτημάτων, σε 
κάτοψη, πλάγια όψη, πρόοψη (εικόνα 3.21, β.). Το σχήμα 1 (εικόνα 3.21, α.), 
σχεδιάστηκε σε τρισδιάστατη μορφή. Χρησιμοποιήθηκαν οι εντολές Extrude για να 
προσδώσει τη διάσταση του ύψους στο αντικείμενο και η Substract, που αφαιρεί τον 
όγκο ενός στερεού από ένα άλλο. Η διάρκεια του μαθήματος είναι 2 ώρες. 

 

 

 

 

 

 

 

 

→                 →  
 

α. 
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β. 

Εικόνα 3.21 -  α. Σχέδιο σε τρισδιάστατη μορφή (3D) 

β. Σχεδίαση εξαρτημάτων, σε κάτοψη, πλάγια όψη, πρόοψη 
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 →  
α. 

 

Εικόνα 3.22 -  α. Σχέδιο σε τρισδιάστατη μορφή (3D) 

β. Σχεδίαση εξαρτημάτων, σε κάτοψη, πλάγια όψη, πρόοψη 

3.2.13 Εργαστηριακή Άσκηση 13 – Σχεδίαση εξαρτημάτων 

Στην εργαστηριακή άσκηση 13, πραγματοποιείται σχεδιασμός εξαρτημάτων (εικόνα 
3.23) και (εικόνα 3.24). Δίνεται μία δυνατότητα επανάληψης των θεωρητικών και 
πρακτικών γνώσεων που έχουν αποκτηθεί μέχρι την Εργαστηριακή Άσκηση 12. Η 
διάρκεια του μαθήματος είναι 2 ώρες. 
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Εικόνα 3.23 -  Σχεδίαση εξαρτημάτων (ομάδα 1) 
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Εικόνα 3.24 -  Σχεδίαση εξαρτημάτων (ομάδα 2) 

3.2.14 Εργαστηριακή Άσκηση 14 – Σχεδίαση εξαρτημάτων 

Στην εργαστηριακή άσκηση 14, πραγματοποιείται σχεδιασμός εξαρτήματος σταθερού 
δισκοειδούς συνδέσμου, σε τομή και κάτοψη (εικόνα 3.25). Όπως και στην 
Εργαστηριακή Άσκηση 13, έτσι και στη συγκεκριμένη άσκηση, δίνεται μία 
δυνατότητα επανάληψης των θεωρητικών και πρακτικών γνώσεων που έχουν 
αποκτηθε. Η διάρκεια του μαθήματος είναι 2 ώρες. 
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Εικόνα 3.24 -  Σχεδίαση εξαρτημάτων 

 

3.2.15 Εργαστηριακή Άσκηση 15 – Σχεδίαση εξαρτημάτων 

Στην εργαστηριακή άσκηση 15, πραγματοποιείται επαναληπτικό μάθημα 
εργαστηρίου για τους απώντες 1 εργσατηριακού μαθήματος, διάρκειας 2 ωρών. Στο 
μάθημα μπορούν να γίνουν και επαναληπτικές ερωτήσεις και να λυθούν οτιδήποτε 
απορίες προκύπψουν από τα προηγούμενα μαθήματα 

 



Συμπεράσματα - Επίλογος 
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Συμπεράσματα - Επίλογος  

Ανακεφαλαιώνοντας και αναλύοντας τα προηγούμενα γραφόμενα συμπεραίνουμε ότι 
το ηλεκτρολογικό σχέδιο μιας εγκατάστασης είναι πάρα πολύ σημαντικό. Σημαντικό 
στο βαθμό που στην εποχή που ο ηλεκτρισμός και η πληροφορία έχει φτάσει σε 
σημείο να είναι απαραίτητα στη καθημερινή μας ζωή. Η τεχνολογία προχωρά γιατί οι 
άνθρωποι προχωράνε. Οι ανάγκες αυξάνονται και συνάμα πρέπει να αυξάνονται οι 
δυνατότητες και οι ευκολίες που μας παρέχει η τεχνολογία. Δυνατότητες οι οποίες να 
μας λύνουν τα χέρια τις περισσότερες φορές ώστε να απομένει ο χρόνος για κάποιες 
πιο ανθρώπινες στιγμές. Η εποχή που ζούμε απαιτεί από τον άνθρωπο, τον εργάτη, 
τον επαγγελματία και κυρίως το μηχανικό να είναι εκπρόσωποι  της τεχνολογίας, 
γιατί μόνο με αυτό τον τρόπο θα μπορούν να εξοικονομούν χρόνο και κόπο, ώστε να 
βελτιώνουν και το βιοτικό τους επίπεδο ταυτόχρονα. Οι υπολογιστές με σωστό 
προγραμματισμό και αρχικώς σωστή σχεδίαση λύνουν τα χέρια του ανθρώπου και 
έτσι διατίθεται περισσότερος χρόνος για την επίβλεψη μιας εργασίας και την 
κατασκευή της.  

Σταματώντας λοιπόν στη σωστή σχεδίαση αισθανόμαστε την ανάγκη να 
δημιουργήσουμε προγράμματα τα οποία να μας βοηθούν στον ορθό εποικοδομητικό 
και γρήγορο σχεδιασμό οποιασδήποτε «μηχανής» η μηχανισμού του οποίου θα 
λειτουργήσει ο άνθρωπος. Πρόγραμμα, όπως το AutoCAD της εταιρείας Autodesk, 
οδηγεί προς αυτή την κατεύθυνση και «λύνει» τα χέρια οποιούδηποτε χρήστη. Το 
μάθημα Ηλεκτρολογικό σχέδιο αποτεέι το σκελετό της προσπάθειας των νέων 
μηχανικών, να βελτιώσουν και συνάμα να εξελίξουν το ηλεκτρολογικό σχέδιο, ώστε 
να ανταποκρίνεται στις απαιτήσεις της παρούσας εποχής αλλά και των μελλοντικών 
εποχών. Η βελτίωση του συκεκριμένου μαθήματος με τη χρήση Η/Υ και 
προγράμματος CAD, είναι στόχος για κάθε νέο μηχανικό είτε βρίσκεται στη θέση του 
εκπαιδευτικού προσωπικού είτε στη θέση του φοιτητή. 

Συνοψίζοντας σε τελική ανάλυση τα πιο πάνω καταλήγουμε στην ανάγκη 
δημιουργίας σωστού προγράμματος για το σχεδιασμό. Με τους τρόπους που 
αναλύσαμε σε αυτή τη εργασία μπορούμε με απλά και μεθοδικά βήματα να 
προγραμματίσουμε το σχεδιαστικό πακέτο του AutoCAD και να το προσαρμόσουμε 
στις δικές μας απαιτήσεις ούτως ώστε να ανταποκριθεί καταλλήλως στο σχεδιασμό 
που θέλουμε να υλοποιήσουμε.  

Συμπεραίνουμε δηλαδή πως για να γίνει μια ολοκληρωμένη δουλειά πρέπει να 
προηγηθεί σωστός και αντικειμενικός προγραμματισμός που θα δίνει την ευκολία στο 
χρήστη να δύναται να σχεδιάσει κάθε λογής εξάρτημα ή εγκατάσταση. Τελειώνοντας 
παραδίδουμε το βάθρο στις επόμενες γενιές οι οποίες με την γνώση που θα 
αποκτήσουν και την απαραίτητη κατάρτιση που θα τους διακατέχει θα βρίσκονται σε 
θέση να υλοποιήσουν προγραμματισμούς που θα είναι σίγουρα πιο σύγχρονοι από 
τους υφιστάμενους και θα έχουν τη δυνατότητα να σχεδιάσουν τις εγκαταστάσεις του 
μέλλοντος. Ενός μέλλοντος που θα μπορεί μέσω της ανάπτυξης της τεχνολογίας να 
στηρίξει τον σύγχρονο μηχανικό. 
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